
 

 

Agile Product Lifecycle Management 

Product Cost Management Supplier Guide 

December 2012 

v9.3.2 

 

Part No. E28689-01 

 



 

 

Copyright and Trademarks 
Copyright © 1995, 2012, Oracle and/or its affiliates. All rights reserved.  

This software and related documentation are provided under a license agreement containing 
restrictions on use and disclosure and are protected by intellectual property laws. Except as 
expressly permitted in your license agreement or allowed by law, you may not use, copy, 
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or 
display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation 
of this software, unless required by law for interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to be 
error-free. If you find any errors, please report them to us in writing. 

If this software or related documentation is delivered to the U.S. Government or anyone licensing it 
on behalf of the U.S. Government, the following notice is applicable: 

U.S. GOVERNMENT RIGHTS 
Programs, software, databases, and related documentation and technical data delivered to U.S. 
Government customers are "commercial computer software" or "commercial technical data" 
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental 
regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject 
to the restrictions and license terms set forth in the applicable Government contract, and, to the 
extent applicable by the terms of the Government contract, the additional rights set forth in FAR 
52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 
Oracle Parkway, Redwood City, CA 94065. 

This software is developed for general use in a variety of information management applications. It is 
not developed or intended for use in any inherently dangerous applications, including applications 
which may create a risk of personal injury. If you use this software in dangerous applications, then 
you shall be responsible to take all appropriate fail-safe, backup, redundancy and other measures 
to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for 
any damages caused by use of this software in dangerous applications. 

Oracle and Java are registered trademarks of Oracle Corporation and/or its affiliates. Other names 
may be trademarks of their respective owners. 

This software and documentation may provide access to or information on content, products and 
services from third parties. Oracle Corporation and its affiliates are not responsible for and 
expressly disclaim all warranties of any kind with respect to third party content, products and 
services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages 
incurred due to your access to or use of third party content, products or services. The RMW product 
includes software developed by the Visigoth Software Society. 



 

 

CONTENTS 

Copyright and Trademarks ............................................................................................................. 2 

Chapter 1 ......................................................................................................................... 1 

Introduction .................................................................................................................... 1 

Overview ............................................................................................................................................. 1 

What is Product Cost Management? ............................................................................................. 1 

Introducing Agile Objects ................................................................................................................ 2 

Sourcing Process ............................................................................................................................... 2 

Login Security and Passwords ....................................................................................................... 3 

Discovery and Read Privileges ....................................................................................................... 3 

Viewing, and Working with, Attachments ................................................................................... 4 

Searching for Objects ...................................................................................................................... 4 

Personalizing PCM Object Tabs ...................................................................................................... 4 

Configuring the display of a tab ...................................................................................................................... 6 

Filtering Objects ....................................................................................................................................................... 6 

Numeric Search and Entry Using Special Characters ............................................................... 7 

What's New in PCM ........................................................................................................................... 7 

New Features in PCM 9.3.2 ................................................................................................................................ 7 

New Features in PCM 9.3.1 ................................................................................................................................ 7 

New Features in PCM 9.3 .................................................................................................................................... 8 

UI Enhancements .................................................................................................................. 8 

Chapter 2 ....................................................................................................................... 11 

Managing Your User Profile ....................................................................................... 11 

Managing Your User Settings ....................................................................................................... 11 

Changing Your User Profile ........................................................................................................... 11 

Changing Your Password ............................................................................................................... 12 

Viewing Sign-off Authority Transfers .......................................................................................... 12 

RFQ Response Edit Mode .............................................................................................................. 12 

Overview of Basic Edit Mode ........................................................................................................................... 14 

Overview of Advanced Wizard Edit Mode ................................................................................................ 17 

Overview of Advanced Table Edit Mode .................................................................................................... 19 



 

 

Chapter 3 ....................................................................................................................... 21 

Managing Supplier Details ......................................................................................... 21 

Managing Your Supplier Profile .................................................................................................... 21 

About the Supplier Manager ......................................................................................................... 21 

Viewing Your Supplier Profile ....................................................................................................... 21 

Fields on the General Info Tab ....................................................................................................................... 23 

Buttons on the General Info Tab .................................................................................................................. 24 

Managing Contact Users ................................................................................................................ 24 

Creating a Contact User ..................................................................................................................................... 25 

Important Profile Fields ..................................................................................................... 25 

Modifying a Contact User’s Information ................................................................................................... 26 

Changing a Contact User’s Password ......................................................................................................... 26 

Deleting a Contact User ..................................................................................................................................... 26 

Managing RFQ Routing .................................................................................................................. 27 

Changing the Default Recipient ................................................................................................... 28 

Defining Manufacturer Offerings ................................................................................................. 28 

Creating a New Manufacturer Offering ...................................................................................................... 28 

Deleting a Manufacturer Offering ................................................................................................................. 30 

Filtering the Manufacturers Tab .................................................................................................................... 30 

Defining Commodity Offerings ..................................................................................................... 30 

Creating a New Commodity Offering .......................................................................................................... 30 

Deleting a Commodity Offering ..................................................................................................................... 31 

Filtering the Commodities Tab ....................................................................................................................... 31 

Editing Manufacturer and Commodity Offerings ...................................................................... 31 

Chapter 4 ....................................................................................................................... 33 

Responding to Request for Quotes ........................................................................... 33 

Working with RFQ Responses ...................................................................................................... 33 

About the RFQ Response Process Flow ..................................................................................................... 34 

About RFQ Response Lifecycle Phase ......................................................................................................... 35 

RFQ Response Actions ........................................................................................................................................ 36 

Bookmarking RFQ Responses ........................................................................................... 36 
Sending RFQ Responses .................................................................................................... 37 
Forwarding RFQ Responses .............................................................................................. 37 
Authorized Users ................................................................................................................. 38 

Completing RFQ Responses .......................................................................................................... 38 

Using the Responses Tab to Respond to RFQs ......................................................................... 39 

Responses Tab ......................................................................................................................................................... 39 



 

 

Responses Table ................................................................................................................. 39 
Responses dropdown Lists ................................................................................................ 40 
Optional Buttons ................................................................................................................. 40 
Response Line Lifecycle Status ........................................................................................ 40 
RFQ Price Scenarios ........................................................................................................... 41 
Pre-defined Views ............................................................................................................... 42 
Entering and Modifying RFQ Response Information .................................................... 42 

Creating Online Responses ........................................................................................................... 42 

Online Edit Methods ............................................................................................................................................. 43 

Advanced Table Edit ............................................................................................................................................. 43 

Advanced Wizard Edit .......................................................................................................................................... 44 

Response Entry Form ......................................................................................................... 45 

Basic Edit .................................................................................................................................................................... 46 

Setting the Expiration Date ............................................................................................................................. 46 

Proposing an Alternate Manufacturer Part .............................................................................................. 46 

Adding an Attachment for an Alternate Part .......................................................................................... 47 

Deleting Proposed Alternate Parts ............................................................................................................... 48 

Looking up Prices ................................................................................................................................................... 48 

Looking Up Contracts, Published Prices, or Quote Histories ..................................... 48 

Creating Offline Responses ........................................................................................................... 49 

Exporting RFQ Response Lines ...................................................................................................................... 50 

Editing Supplier Response Fields in Exported Supplier Response Files .................................. 50 

Valid Values for Supplier Response Fields ..................................................................... 52 

Importing Previously Exported RFQ Response Files .......................................................................... 53 

Viewing BOM Attachments ............................................................................................................ 53 

Costed BOM View ................................................................................................................................................... 53 

Content BOM View................................................................................................................................................. 54 

Assembly Cost Report ......................................................................................................................................... 54 

Submitting Responses......................................................................................................................................... 55 

Reviewing RFQ Response Changes ............................................................................................. 55 

Reviewing Changes to Response Lines ..................................................................................................... 56 

Changing Submitted Responses .................................................................................................................... 56 

Using Discussions ........................................................................................................................... 56 

Adding a Discussion ............................................................................................................................................. 57 

Replying to a Discussion .................................................................................................................................... 57 

Removing Discussions ......................................................................................................................................... 58 

Chapter 5 ....................................................................................................................... 59 

Collaborating on Pricing and Contract Information .............................................. 59 

About Prices ..................................................................................................................................... 59 

Creating Prices ................................................................................................................................ 60 



 

 

General Information Tab ................................................................................................................................... 61 

Changes Tab ............................................................................................................................................................. 62 

Price Lines Tab ........................................................................................................................................................ 62 

Adding Price Lines ............................................................................................................... 64 
Removing Price Lines ......................................................................................................... 65 
Editing Price Lines ............................................................................................................... 65 

Price Lifecycle Phases .......................................................................................................................................... 65 

About Price Change Orders........................................................................................................... 65 

Creating PCOs .................................................................................................................................. 66 

Adding the Current Price Object to an Existing PCO ......................................................................... 67 

Cover Page Tab ....................................................................................................................................................... 68 

Buttons on the Cover Page Tab ....................................................................................... 68 
Fields on the Cover Page Tab ........................................................................................... 68 
Status on the Cover Page Tab ......................................................................................... 69 

Affected Prices Tab ............................................................................................................................................... 70 

Adding Prices ....................................................................................................................... 71 
Auto-populating Effective Date ........................................................................................ 72 
Removing Prices .................................................................................................................. 72 
Editing Prices ....................................................................................................................... 72 

Creating and Editing Price Redlines ............................................................................................................ 72 

Workflow Tab ................................................................................................................................... 73 

Summary Section .................................................................................................................................................. 73 

Workflow Table ........................................................................................................................................................ 73 

User Action Timestamp ................................................................................................................. 74 
  



 

 

Preface 
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 

Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html 
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals 
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation 
folder available on your network from which you can access the Agile PLM documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help 
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or 
information, please contact My Oracle Support (https://support.oracle.com) for assistance. 

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 

Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html. 

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  

http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.adobe.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/education/chooser/selectcountry_new.html
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Chapter 1 

Introduction 

This chapter includes the following: 

 Overview .............................................................................................................................................................. 1 
 What is Product Cost Management? ................................................................................................................... 1 
 Introducing Agile Objects ..................................................................................................................................... 2 
 Sourcing Process ................................................................................................................................................. 2 
 Login Security and Passwords ............................................................................................................................ 3 
 Discovery and Read Privileges ............................................................................................................................ 3 
 Viewing, and Working with, Attachments ............................................................................................................. 4 
 Searching for Objects .......................................................................................................................................... 4 
 Personalizing PCM Object Tabs .......................................................................................................................... 4 
 Numeric Search and Entry Using Special Characters ......................................................................................... 7 
 What's New in PCM ............................................................................................................................................. 7 

 
 

Overview 
Traditional methods for managing and analyzing total product costs throughout the product lifecycle 
are complex, time consuming, and often ineffective. Agile Product Cost Management (PCM) 
supports, enhances, and simplifies these processes, allowing organizations to effectively manage 
and manipulate sourcing content, collaborate with suppliers to establish new sourcing content, and 
analyze the data to drive the best sourcing decision across each product‘s lifecycle. 

The Supplier Interface of Agile PCM helps you manage your RFQ Responses. Depending on your 
assigned roles, you can submit responses to the sourcing manager, view attachments, participate in 
threaded discussions, view the history of your RFQ Responses, import or export RFQ Responses, 
discover previously submitted pricing information, and run reports. 

What is Product Cost Management? 
Agile Product Cost Management (PCM) is an Internet-based solution suite that includes Product 
Sourcing and Contract Management capabilities. 

Product Sourcing manages the preparation and dissemination of Requests for Quotes to suppliers 
and allows analysis of supplier responses. It provides you, the supplier, with a secure, easy-to-use 
interface from which you can receive RFQs, enter your responses, and submit them to your 
customer. 

Contract Management provides the visibility of Contract and Pricing attributes throughout the 
organization and provides workflow approval processes for the release of new contracts, or 
changes to previously released pricing. It also provides visibility to you, the supplier, and allows you 
to participate in workflow processes, as well as proactively initiate a change to contract pricing. 
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Introducing Agile Objects 
In Oracle Agile PLM, you work with objects. Examples of objects are parts, documents, RFQs, RFQ 
Responses, and change orders. 

The objects you can view and the actions you can perform are determined by the roles and 
privileges you are granted to access those objects. Privileges can vary from field to field. If you have 
questions about your roles and privileges, contact the Supplier Manager user in your organization or 
contact the Agile administrator. 

When you open an object, it appears with a number of tabs. Different types of objects have different 
tabs. Each tab contains fields that provide information about that object. For example, a part‘s Title 
Block tab includes Number, Part Category, and Description fields, and a change‘s Cover Page tab 
includes Originator, Status, and Reason For Change fields. 

Some tabs have fields and tables where you enter data; some fields and tables are filled in 
automatically. Some objects and commonly found tabs are mentioned in the discussions later in this 
chapter. 

For more information, see the Getting Started with Agile PLM User Guide. 

Sourcing Process 
Supplier users do the following: 

 Receive email notifications about a Request for Quote (RFQ) from a buyer 

 Accept buyer's terms & conditions before reviewing an RFQ (if Terms and Conditions have 
been enabled and set as required) 

 View data, which may include BOMs, AMLs, and attachments, in an RFQ 

 Provide prices directly into the web application or export data, complete responses and import 
back into Agile PCM 

 Propose alternate parts 

 Analyze historical quoting information 

 Submit the RFQ back to the buyer 

 Configure quote routing so that appropriate supplier users receive RFQ Responses 

 Receive proactive reminders and alerts from the buyer organization to prevent missed 
opportunities 

 Update your own user profile and set preferences, e.g. preferred currency, preferred time zone, 
etc. 

 Update your line card offerings 

 Create your own supplier users 

 Assign alternate users 

 View Costed Bill of Materials 
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Note Some of the actions listed above may be restricted by a user's privileges. If you need 
additional privileges, talk to the Supplier Manager or the Agile administrator. 

 

Login Security and Passwords 
Depending on how the Agile administrator has configured your password settings, you may have 
two separate passwords for login and approval, or you may have one password for both login and 
approval. 

For system security, the Agile administrator may configure the Agile system so that you are not 
allowed to log in after a specified number of password failures (entering the wrong password). The 
lockout applies to both your login password and your approval password. 

Depending on system settings, one of the following occurs: 

 The login lockout lasts until a specified time has passed (for example, one minute). 

After the specified time has passed, a small Login dialog box appears, telling you that there 
have been too many login failures. Click OK and continue. 

 The login lockout lasts until your Agile administrator unlocks your account by changing your 
password. If you are locked out, Web Client hangs for the time period specified by the Agile 
administrator (for example, one minute) each time you attempt to log in. 

 

Discovery and Read Privileges 
Together, the Discovery privilege, the Read privilege, and the Enforce Field Level Read privilege 
determine which Agile objects you can find and open, and which object fields you can view. 

When you search for objects, you may see a message indicating that a number of rows are not 
displayed in the search results table due to insufficient privilege. This indicates that you do not have 
the appropriate privileges to find or discover those objects. You may see that some fields in the 
search results table contain the notation ―No Privilege.‖ This indicates that you do not have the 
appropriate privileges to view the information in that field. 

When you open an object, you may see the notation ―No Privilege‖ in one or more fields. This 
indicates that you do not have the appropriate privileges to view the information in that field. 

If you have questions about your assigned privileges, contact the Supplier Manager user at your 
supplier organization or contact the Agile administrator. 

The Discovery privilege lets you discover the existence of an object in the Agile database. If you do 
not have Discovery privilege for an object, you cannot view the object, and you cannot find, or 
discover, the object in the Agile database. This includes viewing users in the address book; there 
may be some users that you cannot view due to lack of privileges. 

Once you have the privilege to discover an object, your Read and Enforce Field Level Read 
privileges for that object determine whether you can open and view it, and which individual fields 
you can view. You may be able to read an object, but you may not have Read privilege for every 
field of that object. So it is possible for you to open an object and, at the same time, be unable to 
view specific fields of that object. 
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Viewing, and Working with, Attachments 
On the Attachments tab of an object, you can attach files and URLs to the current object by 
referencing those files and URLs in a file folder object. On this tab, you can view, copy (Get), print, 
check out and check in attached files if you have the appropriate privileges. Individual attached files 
are stored in File Folder objects and can be attached to multiple objects. 

Note If you have the appropriate privileges for an object type (for example, RFQ Response 
objects), all attachment tasks (including check in, check out, and add) can be performed 
from the Attachments tab of that object. 

For detailed information about file folders and attachment files, see Getting Started with Agile PLM. 

To view a file using AutoVue for Agile viewer, click its File Name link. If the file is viewable in 
AutoVue for Agile, it opens in the viewer. If the file is not viewable in AutoVue for Agile, it opens in 
the native application (for example, Microsoft Excel) if it is installed on your computer. If the 
attachment is a URL, a browser window opens and displays the contents of the URL. 

If you have the appropriate privileges, the Get, Print, Checkout, Checkin, and Cancel Checkout 
buttons are displayed in the attachment table rows. 

The Add button above the table allows you to add attachments by several methods. Add > Files 
attaches one or more files and creates a file folder object containing those files. Add > URLs attaches 
URLs and creates a file folder object for each URL. Add > By Search allows you to search existing file 
folders for the files or URLs you want to attach. For more details about adding attachments, see 
Getting Started with Agile PLM. 

Searching for Objects 
When you want to find objects in Agile PLM (for example, RFQ Responses or Manufacturer Parts), 
you perform a search. Agile provides several types of searches: 

 Quick searches find objects of all types (or only one object type, if one is specified) that match 
the text you specify. 

 Advanced Object Searches find all the objects with fields that match the conditions of the search. 
For example, you could search for parts where the Description field contains ―Computer.‖ 

 Custom searches extend the Advanced Object search to include multiple conditions. 

 Where-used searches find the assemblies in which the BOM contains the items that match the 
search criteria. 

 Relationship searches find objects related to the objects that meet the search criteria. For 
example, you can search for the problem reports that appear on the Relationships tab of 
changes that meet search criteria. 

For complete information about searching for Agile objects, see Getting Started with Agile PLM. 

Personalizing PCM Object Tabs 
On some tabs of PCM objects, you can select which fields to view (and how to view them) to obtain 
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better performance and to meet your specific needs. When you open these tabs for the first time 
after logging in, the default view appears automatically. After that, you can reconfigure the tab 
display by clicking the Personalize button, which brings up the Table Personalization palette. 

Note Although the Personalize button is available for other PCM objects, this section focuses 
on RFQ Responses since it is the object that suppliers most frequently use. 

From the Table Personalization palette, you may be able to: 

 Sort table results by up to three attributes 

For example, on the Discussions tab, you can sort discussions by the Create Date field in 
ascending or descending order. You can further sort the results by discussion Subject in 
ascending or descending order. Sorting is not available on some tabs, including the Responses 
tab. 

 Filter the information based on specified criteria 

For example, on the Responses tab, you may want to view only the response line items that 
need to be requoted. To accomplish this, you can set your filter criteria to be "Response Line 
Status Equal To Requote". For details on how to filter table rows, see Filtering Objects on page 
6. 

 Format/select the fields (columns) that appear on the tab and set the order of the fields 

For example, on the Attachments tab, if the Modified Date field is not visible, you can make it 
visible, as well as change the location of the column to make it easier to find. For example, you 
could make the Modified Date the third column in the Attachments table by changing the order 
in which it appears. 

You can also lock a particular column to ensure that it is always visible as you use the 
horizontal scroll bar. For example, you can lock the Number column so that it is always visible 
as you scroll to view other data to the right of the column. 

You can configure the display of the following RFQ Response tabs: 

 Responses 

 Discussions 

 Relationships 

 Attachments 

 History 

The following table shows the personalization features that are available for each RFQ Response 
tab. 

Tab Name Sort  F i l ter  Format  Propert ies  

Responses  X X X 

Changes     

Discussions 
x X X X 
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Relationships 
X X X X 

Attachments 
X X X X 

History  X X X 

Note On the Sort, Filter, and Format tabs of the Table Personalization palette, you can choose 
to save your preferences as a new view using the Save button. View properties are 
displayed on the Properties tab. 

Configuring the display of a tab 

To configure the display of a tab 

1. Open an RFQ Response and select one of the configurable tabs, e.g. Discussions tab. Click 
Personalize. 

 To sort fields: On the Sort tab, you can select up to three fields by which the table rows 
should be sorted. For each field, choose whether the sort should be done in ascending or 
descending order. 

 To filter data: See Filtering Objects on page 6. 

 To format fields: On the Format tab, select the fields that you want to view on the tab from 

the Hidden Fields list. Click  to move fields into the Displayed Fields list. Use the up/down 
arrows to change the order of appearance of the columns. 

 To lock columns: To lock a field in the Displayed Fields list, select it and click the lock icon.  

Note If the field you select is not the first column in the table, all columns to the left of 
the selected column will also be locked as you use the horizontal scroll bar. 

2. Click Apply to apply the new display. 

Note Once you click Apply, only the current view is affected. Once you go away from the 
current page, the applied view will be lost unless you use click Save to save the view. 
When you make a change to the base view or a pre-defined view, you must click 
Save and then Save As to save the view as a new view. If you later make changes to 
a view that was not pre-defined, you only have to click Save and the changes are 
saved to the existing view. 

Note The attributes available for the RFQ Response tabs vary based on how your Agile PLM 
system has been configured.   

 

Filtering Objects 

The filter tool allows you to filter the rows of a table that is on an object tab, such as the table on the 
Responses tab of an RFQ Response object. 

The Personalize button appears on most tabs and allows you to sort and format table content, as well 
as filter table content. Use the filter tab on the Table Personalization palette to display only the table 
rows you are interested in. 
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To filter data on a tab: 

1. Open the RFQ Response and click on the desired tab. 

2. Click Personalize. The Table Personalization palette appears. 

3. Click  the Filter tab. 

4. Click  the Field dropdown list to select a field by which to filter. 

5. Click  the Operator dropdown list to select a relational operator for the filter. The list of relational 
operators depends on the type of attribute selected. 

6. Select a value for the filter criteria.  

 For text attributes, type a value. 

 For list attributes, click   to select a single or multiple values from available values list. 

7. To add additional filters, click the . 

Note Multi-column filtering is not available on all tabs. 

8. Click Apply. 

Note If you want to save this filter for future use, click Save. 

For complete information about the table personalization features, see Getting Started with Agile 
PLM. 

Numeric Search and Entry Using Special Characters 
When data is entered in a numeric field (either in search criteria or on Page Two or Page Three 
(custom tabs or sections defined by the Agile administrator), if the number is followed by a special 
character, the number is multiplied by the appropriate scaling factor and entered in the database.  

For example, if you enter 25k in a numeric field, the Agile system stores 25000 in the database. Also, 
if you enter 25k in search criteria, the Agile system searches for 25000. 

For a list of all the special characters and what they represent, see Getting Started with Agile PLM. 

What's New in PCM 

New Features in PCM 9.3.2 

New features that affect suppliers in the Agile PCM Release 9.3.2 include the following: 

 The addition of the Acknowledger reviewer role in the workflows of PCOs.  

 The addition of a Functional Team(s) attribute to Prices, PCOs, and Part Groups. 

For more details on these workflow changes, See Getting Started with Agile PLM. 

New Features in PCM 9.3.1 

New features that affect suppliers in the Agile PCM Release 9.3.1 include the following: 
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 Multi-column filtering is available on the RFQ Response-Responses tab. 

 All dates related to prices are now in DateOnly format in GMT. Project periods, RFQ due dates, 
price line effective from/to dates, valid from, and valid until dates are now all in DateOnly 
format. 

 A new configurable attribute is available on the RFQ Response Entry form to allow you to 
explicitly set a start date for prices that have quantity breaks.  The new attribute, Valid From, 
has a default of the current date. 

 
 

New Features in PCM 9.3 

There are several new UI enhancements in Agile PLM that help make your PCM experience more 
efficient and beneficial. An overview of PCM-specific enhancements is provided in the following 
sections. 

UI Enhancements 

There are several new enhancements and changes to the UI in PCM. The following are some of the 
general changes: 

 When filling in list and multi-list fields, you can type ahead values if you already know the value 
you want to enter. If you don't know what value to enter or if whatever value you entered is 
displayed in red font, you can search for the value by clicking the search button. 

 When filling in date fields, you can either type in the date manually or click on the calendar 
button to select a date. 

 The Prices and PCO objects support full view personalization. 

 The RFQ Response and Supplier objects support limited view personalization.  

Note For more information about view personalization in PCM, see Personalizing PCM 
Object Tabs. 

 

UI Enhancements in RFQ Responses 

The following are enhancements that affect the RFQ Response object: 

 Some action buttons, and their menu options, have been rearranged and/or renamed on the 
Responses tab. 

 Filtering is supported in the Responses tab through view personalization.  Multi-column filtering 
is not supported. 

 When using Advanced Table Edit mode, inline table editing is supported for editable fields. 

 The wizard flow diagram in the left pane is no longer displayed. Instead, when using Basic edit 
mode, the diagram is replaced with a text version of the flow steps. The flow is not displayed 
while in other response edit modes. 

 

UI Enhancements in Prices and Price Change Orders 

The following are enhancements that affect the PCO object: 
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 On the Workflow tab, the Summary table and the Signoff History table have been combined 
into one table. Now, the two sections on this tab are the Summary section and the Workflow 
section, which contains the table. 
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Chapter 2 

Managing Your User Profile 

This chapter includes the following: 

 Managing Your User Settings .............................................................................................................................. 11 
 Changing Your User Profile ................................................................................................................................. 11 
 Changing Your Password .................................................................................................................................... 12 
 Viewing Sign-off Authority Transfers ................................................................................................................... 12 
 RFQ Response Edit Mode ................................................................................................................................... 12 

 
 

Managing Your User Settings 

You can access Web Client user settings by clicking the  (in Advanced Table Edit or Advanced 
Wizard Edit response edit modes) or the My Profile button (in Basic response edit mode). 

This chapter includes the following topics: 

 Changing Your User Profile 

 Changing Your Password 

 Viewing Signoff Authority Transfers 

 RFQ Response Edit Mode 

Note Supplier Managers can see and modify additional information on the Administrator page. 
For details, see Managing Supplier Details on page 21. 

 

Changing Your User Profile 
Your user profile contains a variety of information about how to contact you, your date and time 
preferences, and several Agile Web Client onscreen display preferences. You have an opportunity 
to enter information when you first log in to Agile Web Client. 

To edit, or add information to, your user profile: 

1. Click or My Profile to open your user profile. 

Note The  icon does not appear in all response edit modes. In Advanced Table Edit 

and Advanced Wizard Edit response edit modes, the  icon appears in the 
Courtesy Controls area. In Basic response edit mode, the My Profile button appears 
instead in the toolbar at the top of the right pane. 

2. Click the tab on which you want to make changes. 

3. To make changes to the General Info and Preferences tabs, click Edit and use the lists, browse 
buttons, and text boxes to enter the requested information.  
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4. In the Escalations tab, you can add new notifications, by clicking Add, or remove existing 
notifications by selecting the row(s) and clicking Remove. To make changes, click directly in the 
field you want to edit and make changes, as needed.  

 

Changing Your Password 
If you have a separate approval password, the process to change your approval password is similar 
to using the Change Approval Password option. 

To change your login password: 

1. Click or My Profile to open your user profile. 

Note The  icon does not appear in every response edit mode. In Advanced Table Edit 

and Advanced Wizard Edit response edit modes, the icon appears in the 
Courtesy Controls area. In Basic response edit mode, the My Profile button appears 
in the toolbar at the top of the right pane. 

2. Click Change Passwords. The Change Passwords dialog appears. 

3. Type your old login password in the Login Password field. 

4. Type your new login password in the New Login Password and Confirm Login Password fields. 
(Passwords are case-sensitive.) 

5. Fill in the Approval Password fields. 

Note If the Use Login Password for Approval field in your profile is set to Yes, then you see 
only the Login Password fields. 

6. Click Save. 

If you have not followed the rules defined in your Agile system for selecting passwords, you are 
prompted to correct your password. 

Viewing Sign-off Authority Transfers 
An Agile user with the appropriate privileges can have sign-off authority transferred from you to 
another user or from another user to you. This is useful when, for example, you are out of the office 
and unavailable to sign-off on changes, such as price change orders (PCOs). 

To view transfers that have been set up for you, click or the My Profile button, as appropriate, to 
open your user profile and then click the Transfer Authority button. 

If you are a price collaborator (you have the ability to approve PCOs), you may have the ability to 
create sign-off authority transfers for yourself. For information about how to create, modify, and 
delete sign-off authority transfers, see the topic about routing objects with workflows in Getting 
Started with Agile PLM. 

RFQ Response Edit Mode 
You can enter RFQ line item responses using one of the following three edit modes: 
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 Basic 

 Advanced Wizard Edit 

 Advanced Table Edit 

You can select the response entry mode you want to use from within the Preferences tab of your user 
profile. You can change your selection at any time. If you like, experiment with each response entry 
mode to discover which one you prefer. 

Note In all three response edit modes, you can choose to export response lines, complete 
them and then import them back into the RFQ Response. 

To switch between entry modes: 

1. Click or My Profile, depending on your Response Edit Mode preference, to open your user 
profile.  

2. Go to the Preferences tab, and click Edit. 

3. From the Response Edit Mode dropdown list under Display Preferences, select the method you want 
to use. 

4. Click Save. 

For more details about the various methods for entering response information, see Entering and 

Modifying RFQ Response Information on page 42. 
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Overview of Basic Edit Mode 

If you choose to use the Basic edit mode, when you log into PCM, you see the Welcome page. In 
the left pane, there are quick links that you can use to filter requests. For example, you could click 
the Due Today link to view requests that are due today. 
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When you open an RFQ, you only see the Cover Page without any tabs. Instead of tabs, there are 
links in the left pane that allow you to step through the process of viewing, completing, and 
submitting responses. 
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You must use the links in the left pane to navigate through the process. The first three links are in 
the order that you would want to view the RFQ, i.e. view the Cover Page, attachments, and then the 
line items. For example, to view line items, click the link, 3. View Line Items. The following is an 
example of an RFQ Response's line items. 

 

When editing line items, the Basic edit mode displays a single page, the Response Entry dialog, for 
each line item. You fill out the fields for one line item, then click the Next button to save your entries 
and go to the next line item in the RFQ. For more information about the form used to edit responses 
in Basic edit mode, see Response Entry Form. For more information about this mode, see Basic 

Edit on page 46. 
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Overview of Advanced Wizard Edit Mode 

If you choose the Advanced Wizard Edit mode, when you log into PCM you see the Welcome page. 
As shown below, in this edit mode, you have access to the Folders, Reports, and much more in the 
left pane.  
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As shown below, when you open an RFQ Response in this mode, there are tabs that help you 
navigate through viewing the line items, the attachments, and other data relevant to the RFQ. 

 



 Chapter 2: Managing Your User Profile 

 

 

 19  

  

To view line items, you can click on the Responses tab. The Responses table contains details for 
the line items. 

 

When editing line items, the Advanced Wizard Edit mode displays a single page, the Response 
Entry dialog, for each line item. You fill out the fields for one line item, then click the Next button to 
save your entries and go to the next line item in the RFQ. For more information about the form used 
to edit responses in the Advanced Wizard Edit mode, see Response Entry Form. See Advanced 
Wizard Edit for more details about this mode. 

Overview of Advanced Table Edit Mode 

If you choose the Advanced Table Edit mode, when you log into PCM you see the Welcome page. 
This mode is very similar to the Advanced Wizard Edit mode, as described in Overview of 

Advanced Wizard Edit Mode on page 17. The difference between the two modes is how line items 
are edited. In this mode, when you want to edit a field, you type directly into the editable field. Not 
all fields are editable. 
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The image below shows how a field appears when it is being edited.  

 

For more details about editing RFQ Responses in the Advanced Table Edit mode, see Advanced 
Table Edit. 
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Chapter 3 

Managing Supplier Details 

This chapter includes the following: 

 Managing Your Supplier Profile ........................................................................................................................... 21 
 About the Supplier Manager ................................................................................................................................ 21 
 Viewing Your Supplier Profile .............................................................................................................................. 21 
 Managing Contact Users ..................................................................................................................................... 24 
 Managing RFQ Routing ....................................................................................................................................... 27 
 Changing the Default Recipient ........................................................................................................................... 28 
 Defining Manufacturer Offerings .......................................................................................................................... 28 
 Defining Commodity Offerings ............................................................................................................................. 30 
 Editing Manufacturer and Commodity Offerings .................................................................................................. 31 

 
 

Managing Your Supplier Profile 
The Supplier Interface of Agile PCM helps you manage your RFQ Responses. The sourcing 
manager creates the RFQ and sends it to the suppliers. As a supplier user, you can submit 
responses to the sourcing manager, view attachments, view the history of your RFQ Responses 
and (with the appropriate privileges) import or export responses, run reports, and collaborate in 
price management. For more information, see Responding to Request for Quotes on page 33 and 
Collaborating on Pricing and Contract Information on page 59. 

About the Supplier Manager 
The Supplier Manager is the user at a supplier organization who maintains his supplier 
organization's profile, line card offering, users, and RFQ routing setup. 

If you have the (Restricted) Supplier Manager role, you can perform administrative tasks. You can 
view or modify the profile details of your supplier organization. The supplier profile records important 
manufacturer and commodity information for your company.  

Viewing Your Supplier Profile 
The easiest way to view your supplier profile is to search for it, and bookmark it. Whenever you 
need to view or modify your supplier profile, click its bookmark in the navigation pane on the left 
side of the Agile Web Client window. 

 To bookmark your supplier profile: 

1. In the top menu bar, click the next to the  button and select Supplier from the dropdown 
list. 

2. Enter your company name in the search field or simply enter * for a wildcard search. 

3. Click  to run the search. 
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4. In the search results (if more than one supplier name appears), click the link for your supplier 
organization in the Number column. 

The tabbed object for your supplier profile is displayed. 

5. From the Actions dropdown list, select Bookmark. 

In Shortcuts in the navigation pane on the left, a bookmark for your supplier organization 
appears under My Bookmarks. You can use this bookmark at any time to open your supplier 
profile. 

Just as your user profile object displays information about you and your user preferences, the 
supplier profile object displays information about your supplier organization and the settings you 
choose to use. The appropriate buyer user (Organization Manager) creates suppliers. You can view 
this information and edit some of the information on the tabs of your Supplier profile. 

The following table shows the tabs and the default fields for suppliers. 

Suppl ier  tab name  Defau l t  f ie lds  inc lude  Tab in format ion  
includes 

General Info Name, DUNs, Description, Web Supplier, 
Address, City, Country/Area, 
Region/Province/State, Postal/Zip Code, 
Phone, Fax, URL, Corporate Currency, 
Create User 

General information about the 
supplier organization. 

Contact Users  User ID, First Name, Last Name, E-Mail, 
Business Phone, Status 

Contains all associated or 
created supplier users. 

RFx Routing  Continent, Region/Province, User ID, First 
Name, Last Name, E-Mail, Business Phone, 
Status 

RFQ routing information. 

Manufacturers  Manufacturer Name, Rating, Ship-To Manufacturer line information. 

Commodities  Commodity Name, Rating, Ship-To Commodity information. 

PSRs  Product Service Request (PSR)  Number 
and other related fields 

PSR information 

Note This info is visible only if 
you have the requisite 
privileges. 

Relationships Name, Description, Current Status, Rule and 
Type 

View Completed, Pending, 
and Rules not Specified, or 
All Relationships  

Attachments File Name, File Description, Checkout User, 
Checkout Date, Checkout Folder, Modified 
Date, File Version, File Size, File Type, Last 
View Date 

Add files, URLs; Get 
Shortcuts to Files; View Files, 
URLs. 

History Action, User, Local Client Time, Details and 
Comments 

Track changes and events.  

The General Info tab has fields that contain the general information about the supplier profile object. 
Some fields are filled in automatically; you complete the rest. 



 Chapter 3: Managing Supplier Details 

 

 

 23  

  

To edit supplier information, click the Edit button. You cannot edit the contents of some fields. 

Note You can use the Agile PLM Help system for more information. From the courtesy 

controls in the left pane, click the  button and select Help from the dropdown list. 
 A window appears with a link to the Agile PLM Documentation Web site 
http://www.oracle.com/technology/documentation/agile.html, as well as a link to the User 
Productivity Kit help topics. 

 

Fields on the General Info Tab 

The General Info tab of a Supplier object contains the fields that are listed in the following table. The 
Agile administrator can add custom fields to the General Info tab. 

Field  Descr ipt ion  Edi table?  

Name Name of the supplier. No 

Supplier Type Indicates if the supplier is of the 
following types: 

 Component Manufacturer 

 Contract Manufacturer 

 Broker 

 Distributor 

 Manufacturer Representative 

No. 

Note that the Agile administrator can create or 
rename supplier types, as needed. The supplier 
type assigned to your supplier organization may 
not appear on this list. Contact the Agile 
administrator or the Agile Organization Manager 
if you have questions about your supplier type. 

Lifecycle Phase Indicates if this supplier is active or 
not. 

No 

Note that if you do not have privileges to view 
the object, the area that would normally display 
the lifecycle phase will display "No Privilege." 

Number Supplier number assigned to the 
supplier when it was created. 

No 

DUNs The industry standard Data 
Universal Numbering System 
(DUNs) number. 

Yes. 

If your supplier organization uses a DUNs 
number, enter that number here. 

Display Name Display name of supplier. No 

Description Text that describes the supplier. The 
maximum length is set by the Agile 
administrator. 

Yes 

Web Supplier Indicates if this supplier logs in to 
the Web Client or receives offline 
communication (Yes / No). 

Yes.  

To use the Agile Web Client to complete and 
submit RFQ Responses, you must set this field 
to Yes. 

Corporate Currency The default currency for this 
corporation. 

Yes.  

Select a currency from the drop-down list. 

http://www.oracle.com/technology/documentation/agile.html
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Field  Descr ipt ion  Edi table?  

Address Address. Yes.  

Enter the correct contact information for your 
supplier organization. 

Geography Your Country / Continent No  (only editable by an Agile administrator) 

City City. Yes 

Postal/Zip Code Postal or Zip code. Yes 

Phone Phone number. Yes 

Fax Fax number. Yes 

URL URL for supplier Web site. Yes 

Maximum Number of 
Contact Users 

The maximum number of supplier 
users that can be created for this 
supplier. 

No  (only editable by an Agile administrator) 

Maximum Number of 
Licensed Contact 
Users 

The maximum number of supplier 
users that can be assigned a 
concurrent user license. 

No  (only editable by an Agile administrator) 

Max Number of Named 
Contact Users 

The maximum number of supplier 
users that can be assigned a power 
user license. 

No  (only editable by an Agile administrator) 

Default RFQ Recipient The contact user who automatically 
receives all RFQs sent to this 
supplier. 

Yes 

Default Declaration 
Recipient 

The contact user who automatically 
receives all declarations for this 
supplier. 

Yes 

 
 

Buttons on the General Info Tab 

The General Info tab of a Supplier object contains the following buttons: 

 Edit — appears when the General Info tab is not in edit mode. To edit the General Info tab, click 
Edit. 

 Save — appears when the General Info tab is in edit mode. To save the changes that you made 
to the tab while it was in edit mode, click Save. 

 Cancel — appears when the General Info tab is in edit mode. To undo the changes that you 
made to the tab while it was in edit mode, click Cancel. 

 

Managing Contact Users 
If you have the (Restricted) Supplier Manager role, you can perform administrative tasks. You can 
view or modify the profile details of your supplier organization. The supplier profile records important 
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manufacturer and commodity information for your company. 

The Contact Users tab of your supplier organization profile lists all the users associated with or 
created for your supplier organization. Open your supplier profile object and click the Contact Users 
tab. For details, see Viewing Your Supplier Profile on page 21. 

You can click the Personalize button to specify criteria for viewing only certain information on this tab. 
For more information, see Personalizing PCM Object Tabs. 

Creating a Contact User 

Users with the (Restricted) Supplier Manager role can create new contact users. 

To create a new supplier user in Web Client: 

1. Open a supplier and click the Contact Users tab. 

2. Click the Add button. 

3. Click the  button. The Create New dialog appears. 

4. Enter the Username. Type the Login Password, and retype it to confirm. 

5. Enter the Approval Password and retype it to confirm. 

Note If you want to use the same password as what you entered for the Login Password, 
select the Use Login Password for Approval checkbox. This will disable the Approval 
Password fields. 

6. Enter user details - First Name, Last Name, and Email.  

7. Click Add. 

Note The supplier must be web-enabled in order for the new user to be able to log into the 
system. 

 

Important Profile Fields 

Once a contact user is created, you may consider changing some of the following contact user 
fields: 

 Roles – the user‘s role assignments, which determine a user‘s access to Agile objects. 

 Lists – the routable object manager lists on which the user‘s name appears, for example, the 
Change Analyst list (depending on your privileges, this field may not be editable). 

 Searches – determines which predefined search folders are available to the user, for example, 
the Change Analyst searches (depending on your privileges, this field may not be editable). 

 Use Login Password for Approval – if set to Yes, use one password (login password) for both login 
and routable object, e.g. PCO, approval. 

 Allow Escalation Designation Approval – this setting determines whether the user‘s designated 
escalation persons can approve a routable object for the user only After Escalation or Always. 

 Sites, Default Site – the list of manufacturing sites where the user is involved. The Default Site is 
the user‘s main base of work. 
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The General Info tab also includes fields for contact information such as mailing address and phone 
numbers. 

For detailed information about all the User object fields, see the Administrator Guide. 

Modifying a Contact User’s Information 

You can make modifications, such as changing the password and specifying whether the user is 
active or inactive, to the contact user's information. 

To modify contact user information: 

1. Search your supplier. For details, see Viewing Your Supplier Profile on page 21. 

2. Click on your Supplier Name/Number link. The supplier object appears. 

3. Click the Contact Users tab.  

4. Click the User ID link. The User page appears. 

5. To modify General Info tab data, click Edit. Make changes as required. 

6. To enable or disable the user, select Active or Inactive in the Status dropdown list. An inactive 
user cannot log in to Agile and, therefore, cannot respond to RFQs. 

7. To save the changes that you made to the User page while it was in edit mode, click Save. To 
undo the changes that you made to the User page while it was in edit mode, click Cancel. 

 

Changing a Contact User’s Password 

You might need to change or reset a user‘s password. 

To reset a user password: 

1. Open the supplier object and click the Contact Users tab. 

2. Click the User ID link for the user whose password needs to be changed. The User page 
appears. 

3. In the General Info tab, click the Change Password button. The Change Password dialog appears. 

4. Type the new login password in the New Login Password and Confirm Login Password fields. 
(Passwords are case-sensitive.) 

5. Fill in the Approval Password fields. 

Note If the Use Login Password for Approval field in the user's profile is set to Yes, then you 
see only the Login Password fields. 

6. Click Save. 

Note If you have not followed the rules defined in your Agile system for selecting 
passwords, you are prompted to correct your password. 

 

Deleting a Contact User 

You may want to delete a contact user if that person no longer works at your organization. 
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To delete contact user information: 

1. Open the supplier object and click the Contact Users tab. 

2. Click the User ID link for the user who needs to be deleted. The User page appears. 

3. In the Actions menu, choose Delete. 

Note You can delete a contact user only if the contact user is not set as the Default RFQ 
Recipient for a supplier. If you want to delete the current default, you must set 
another contact user as the Default RFQ Recipient before you can delete it. 

4. When the confirmation prompt appears, click OK. 

The user remains listed on the Contact Users tab, but the user's status changes to Inactive. 

Managing RFQ Routing 
When a buyer sends an RFQ, it is based on a specific Ship To location. In a supplier organization, 
you can choose to have the system send notifications of RFQ Responses to specific users based 
on the Ship To location in the RFQ. Note that, if there are multiple supplier users assigned to the 
same Ship To location, only one of them gets a notification. You can configure the routing rules in 
the supplier object's RFx Routing tab.   

If you do not specify RFQ routing rules, all RFQs are sent to the default recipient. The default 
recipient must then forward each RFQ to the appropriate contact user. 

Note You must have the (Restricted) Supplier Manager role to set up RFQ routing. 

To add a new routing rule: 

1. Open a supplier, and then click the RFx Routing tab. 

2. Click Add. 

3. Select a user from the Contact dropdown list. 

4. Specify the Geography by selecting the continent, country/area, and state/province/region to 
associate with the contact user. 

5. Click Add. 

To edit a rule: 

1. Open a supplier, and then click the RFx Routing tab. 

2. Make the required changes directly to editable fields, e.g. Continent. 

3. To undo the changes that you made to the RFx Routing tab, click Cancel. To save your changes, 
click Save. 

To delete a rule: 

1. Open a supplier, and then click the RFx Routing tab. 

2. Select the routing rule that you want to delete. 

3. Click Remove.  
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To change the default recipient: 

1. Open a supplier, and then click the General Info tab. 

2. Click Edit. 

3. Select the Default RFQ Recipient from the list of contact users for the supplier. 

4. Click Save. 
 

Changing the Default Recipient 
After a supplier is created, the first contact user that is added becomes the default RFQ recipient. 
The default recipient receives any RFQs that could not be routed based on a routing rule. You can 
change the default recipient at any time. 

To change the default recipient: 

1. Open the supplier and click the General Info tab. 

2. Click Edit. 

3. Use the dropdown list next to the Default RFQ Recipient field to select a user. 

4. Click Save. 
 

Defining Manufacturer Offerings 
Suppliers have two types of line cards—manufacturer and commodity. Manufacturer offerings 
define which product lines are carried by a manufacturer. Commodity offerings define which product 
lines are associated with a commodity. 

The manufacturer line card is a detailed list that maps each manufacturer whose goods you carry to 
a specific geographic location where those goods are available. This is a way to indicate the 
manufacturers whose goods you are franchised to offer in certain geographic regions.  

For example, a supplier called ACME Corp. might sell Motorola and Kemet products. The supplier 
should have one manufacturer line card per manufacturer per location. 

The manufacturer line card is one of the settings that determine which RFQs you receive from 
buyers. 

When you update the geographical information or Ship To locations for a manufacturer or 
commodity for a line card, the organization manager receives a notification in his inbox so that he 
can approve the line card offering. 

Note You must have the correct privileges to add and remove manufacturer offerings. The 
Agile PLM Administrator needs to modify your (Restricted) Modify My Supplier Profile 
privilege. 

 

Creating a New Manufacturer Offering 

You can specify general information about manufacturer offerings from the Manufacturers tab. Each 
manufacturer line card definition is a unique combination of manufacturer, supplier, and Ship To 
locations. You can have multiple lines for each manufacturer, with each line for a manufacturer 
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associated with a different Ship To location. If there are changes to the geographic locations where 
the goods are offered, then you can edit the manufacturer line cards. 

When you create an offering, make sure the geographical data you specify is not narrower than an 
existing offering for the same manufacturer or commodity. For example, if the 
Region/Province/State for an existing offering is set to all locations (by selecting the root Location 
folder), you can not create a new offering for the same manufacturer or commodity with the 
Region/Province/State set to California because the existing offering covers a broader region. 

If you choose to add a manufacturer offering by Geography, rather than Ship To location, an 
offering is only added if there is a Ship To location defined in that particular region.  

For example, assume that the following are the only Ship To locations defined in the system: 

 Santa Clara, CA, USA 

 Los Angeles, CA, USA 

 Bangalore, India, Asia 

If a user uses the Geography option and selects San Jose, CA, USA as the geographical location, 
the system does not add any rows to the Manufacturers table, because there are no Ship To 
locations defined for that specific location. On the other hand, if the user selects CA, USA as the 
location, the Santa Clara, CA, USA and Los Angeles, CA, USA Ship To locations are added, 
because those locations are included in the broader region of CA, USA. 

 To create a new manufacturer offering: 

1. Open the supplier object. 

2. Click the Manufacturers tab. 

3. Click the Add button. The Add Manufacturer Offerings dialog appears. 

4. If you already know the manufacturer name, type it into the field. Otherwise, you can click the 

 button to select the Manufacturer Name. Searches are provided to lead you through the 
process of selecting a manufacturer. 

Note Depending on your privileges, you may also be able to create a new manufacturer 

by clicking . 

5. Select a For Locations option. You can define the offering by a Ship To location or by 
Geography, which defines the continent, country, and area. 

6. If you selected Geography, click   to specify the continent, country/area, and 

state/province/region. If you selected Ship To, specify one or more locations by clicking the  
icon or by simply typing the location(s) into the field. 

7. Select the Rating from the dropdown list.  

Note During the RFQ dissemination process, suppliers receive notifications based on the 
rating criteria set by the buyer when the RFQ is created. 

8. Click Add to complete the operation. The new manufacturer line card definition appears in the 
list. 
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Deleting a Manufacturer Offering 

You can delete a manufacturer offering. 

To delete an offering: 

1. Open the supplier object. 

2. Click the Manufacturers tab. 

3. Select the row(s) of manufacturer offering(s) that you wish to delete.  

4. Click Remove. 
 

Filtering the Manufacturers Tab 

You can filter the Manufacturers tab to display only certain information. Click the Personalize button to 
specify what information you want to see. For more information, see Filtering Objects on page 6. 

Defining Commodity Offerings 
Your commodity offerings define the categories of product you sell. For example, a supplier called 
ACME Corp. might sell commodities such as fuses, integrated circuits, and resistors. The 
commodity line card is a detailed list that maps each commodity you carry to a specific geographic 
location where those goods are available. 

Note You must have the correct privileges to add and remove commodity offerings. The Agile 
PLM Administrator needs to modify your (Restricted) Modify My Supplier Profile 
privilege. 

 

Creating a New Commodity Offering 

You can specify general information about the commodity offerings from the Commodities tab. Each 
commodity line card definition is a unique combination of commodity and Ship To locations. You 
can have multiple lines for each commodity, with each line of a commodity associated with different 
Ship To locations. If there are changes to the geographic locations where the goods are offered, the 
Supplier Manager can edit the commodity line cards for your supplier organization. 

If you choose to add a commodity offering by Geography, rather than Ship To location, an offering 
is only added if there is a Ship To location defined in that particular region.  

For example, assume that the following are the only Ship To locations defined in the system: 

 Santa Clara, CA, USA 

 Los Angeles, CA, USA 

 Bangalore, India, Asia 

If a user uses the Geography option and selects San Jose, CA, USA as the geographical location, 
the system does not add any rows to the Commodities table, because there are no Ship To 
locations defined for that specific location. On the other hand, if the user selects CA, USA as the 
location, the Santa Clara, CA, USA and Los Angeles, CA, USA Ship To locations are added, 
because those locations are included in the broader region of CA, USA. 



 Chapter 3: Managing Supplier Details 

 

 

 31  

  

To create a new commodity offering: 

1. Open the supplier object. 

2. Click the Commodities tab. 

3. Click the Add button. The Add Commodity Offering dialog appears. 

4. If you already know the commodity name, type it into the field. Otherwise, you can click the  
button to select the Commodities.  

Note Depending on your privileges, you may also be able to create a new commodity by 

clicking . 

5. Select a For Locations option. You can define the offering by a Ship-to location or by Geography, 
which defines the continent, country, and area. 

6. If you selected Geography, click  to specify the continent, country/area, and 

state/province/region. If you selected Ship To, specify one or more locations by clicking the  
icon or by simply typing the location(s) into the field. 

7. Select the Rating from the dropdown list. 

Note During the RFQ dissemination process, suppliers receive notifications based on the 
rating criteria set by the buyer when the RFQ is created. 

8. Click Add to complete the operation. The new commodity line card definition appears in the list. 
 

Deleting a Commodity Offering 

You can delete a commodity offering. 

To delete a commodity offering: 

1. Open the supplier object. 

2. Click the Commodities tab. 

3. Select the row(s) of the commodity offering(s) that you want to delete.  

4. Click Remove. 
 

Filtering the Commodities Tab 

You can filter the Commodity tab to display only certain information. Click the Personalize button to 
specify what information you want to see. For more information, see Filtering Objects on page 6. 

Editing Manufacturer and Commodity Offerings 
You can edit a manufacturer offerings and commodity offerings. To edit an offering on the 
Manufacturers or Commodities tab of the supplier, click directly in the field you want to edit and 
make changes, as needed. Some fields may not be editable. 
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Note For the first field you attempt to edit, you will have to double-click in it to make it editable. 
Any subsequent fields will only require a single-click to enable editing. 

While editing, you can edit multiple rows simultaneously by using the Fill-up and Fill-down options via 
the More button. For example, if you changed the Rating field for one offering, but wanted the same 
rating value for a few of the offerings below it, you can select the Rating table cell for the offerings 
that should be copied and the Rating cells of the offerings to which you want the value copied. 
When you click More > Fill-down (selected cells) the value that was in the first price line that you 
selected is copied to the selected cells below it. Note that there are also keyboard shortcuts 
available for these edit options. 
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Chapter 4 

Responding to Request for Quotes 

This chapter includes the following: 

 Working with RFQ Responses ............................................................................................................................. 33 
 Completing RFQ Responses ............................................................................................................................... 38 
 Using the Responses Tab to Respond to RFQs .................................................................................................. 39 
 Creating Online Responses ................................................................................................................................. 42 
 Creating Offline Responses ................................................................................................................................. 49 
 Viewing BOM Attachments .................................................................................................................................. 53 
 Reviewing RFQ Response Changes ................................................................................................................... 55 
 Using Discussions ............................................................................................................................................... 56 

 
 

Working with RFQ Responses 
Buyers send requests for quotes (RFQs) to their suppliers to get price quotes. The sourcing 
manager assigns you the (Restricted) RFQ Responder role so you can respond with the requested 
price information and submit your responses. 

As an RFQ responder, you can: 

 Determine the bid or no-bid decision for each part, and complete the requested response 
information for the parts you have chosen to bid. 

 Propose alternate parts, instead of the part specified in the RFQ, from a manufacturer not in 
Agile database. 

 Provide material and non-material price information. 

When a buyer creates an RFQ, one or more RFQ Response objects are created for your supplier 
organization. If you are the owner of the RFQ Response, a notification appears in your Notification 
Inbox. You may also get a notification email, depending on notification settings. 

You can respond to RFQs within PCM, or you can export the response line items to a text file and 
use an external text editor, such as Microsoft Excel, to respond. In Advanced Wizard Edit mode and 
Advanced Table Edit mode, you view RFQ Response information on a set of tabs on the RFQ 
Response object page. In Basic edit mode, the RFQ Response information is displayed on pages 
that are accessible via hyperlinks. 

Note For information about entering and submitting RFQ response information, see 
Completing RFQ Responses on page 38. 

Before you can proceed with an RFQ, you may be required to accept the Terms and Conditions, if 
they have been set mandatory by the buyer. Should you choose to decline, you will not be able to 
view the RFQ and you will be returned to your Notifications Inbox. These Terms and Conditions 
prescribe buyer‘s expectations and RFQ-specific stipulations. 

If you forward an RFQ to another user in your organization, he or she must also accept the Terms 
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and Conditions to proceed further with it. 

The following table describes each RFQ Response object tab and the actions you can perform from 
each one. 

Tab Descr ip t ion  Act ions 

Cover Page Displays general details about the RFQ Response. View RFQ Response details. 

Responses Displays response line details, and lets you filter 
the response information to view specific details, 
and perform various response entry tasks. 

Filter the view of response details. 
Propose alternate manufacturer parts. 
Enter or modify response details. 
Set expiration dates. 
Export or import response line details. 
Submit selected response lines. 

Changes Displays changes made to the RFQ Response by 
the sourcing manager. 

View change details by item view or 
response view. 
View item change summary by items 
that were added, deleted, or changed.  

Discussion Displays the discussion objects related to the RFQ 
Response. 

View the list of discussions in the table 
to reply, delete, and add discussions. 

Attachments Displays any file attachments for the RFQ 
Response. 

View file attachment details. Edit, 
remove, and add attachments. 

History Displays a list of actions performed during the life 
of the RFQ Response. 

View user, date, time, and description 
for each action. 

 
 

About the RFQ Response Process Flow 

The RFQ Response process flow is shown in the following diagram 
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In Basic edit mode, a list of the process flow steps is displayed in the left pane. 

 View Cover Page — Takes you to the RFQ Cover Page where you will find general information 
about the RFQ. 

 View Attachments — Opens the RFQ Response Attachments tab so you can view attachments. 

 View Line Items — Opens the RFQ Response Responses tab. 

 Enter Responses — Selects all items in the RFQ and lets you fill in cost information using your 
preferred response edit mode.  

 Export Responses (xls) and Export Responses (csv) — Selects all items in the RFQ and lets you 
export the RFQ so that you can work offline on your response. 

 Import Responses — Opens the import wizard so that you can import the work you have 
completed offline. 

 Submit — Saves your work if you have not already done so, then sends all valid responses to 
the sourcing project manager. 

In Basic mode, you can click a link in the process flow list to initiate that action. If the action requires 
a selection, you are redirected to the appropriate page to make the selection. In some instances, 
you cannot go to a step in the process until you have completed the previous step. 

In Advanced Table Edit and Advanced Wizard Edit modes, you can complete these actions using 
the menu buttons on the tabs of the RFQ Response object. 

About RFQ Response Lifecycle Phase 

The lifecycle phases of RFQ Response are listed in the table below. 
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Lifecycle  
Phase 

Descr ipt ion  

New New indicates that you have not yet opened and reviewed the RFQ Response. This is 
the lifecycle phase of an RFQ Response when it first appears in your inbox. 

Open Open indicates that you can modify and work with the RFQ Response. When you open 
a new RFQ Response, the lifecycle phase changes to Open. You can modify an open 
RFQ Response, including entering response information on the Responses tab and 
submitting responses. 

Locked Locked indicates that the sourcing manager has locked the RFQ associated with this 
RFQ Response. Suppliers cannot make any modifications to the Responses if the Buyer 
has locked the RFQ. Although you may be able to still enter data, the system throws an 
error if you attempt to save any changes. 

Closed Closed indicates that the sourcing manager has closed the RFQ associated with this 
RFQ Response. You cannot make any modifications to an RFQ Response in the closed 
lifecycle phase. 

 
 

RFQ Response Actions 

When you view an RFQ Response in either Advanced Table Edit mode or Advanced Wizard Edit 
mode, the Actions menu appears above the tabs. This menu applies actions to the entire RFQ 
Response object. Use the Actions menu commands to send or forward the RFQ Response or to 
create a bookmark. 

The RFQ Response Actions menu allows you to: 

 Bookmark the RFQ Response for fast, convenient access. 

 Send the RFQ Response to other users with appropriate privileges. 

 Forward your RFQ Response to another user within your company. 

 Subscribe to an RFQ Response so that you can be notified when any field that you have 
subscribed to is modified. 

 Share the RFQ Response with another user by granting one or more of your roles to another 
Agile PLM user for the current RFQ Response object. 

 Copy a URL to the clipboard. 
 

Bookmarking RFQ Responses 

Bookmarks are links you create for quick access to open the RFQ Responses you are working on. 
To create a bookmark for an RFQ Response, open the RFQ Response and choose Bookmark from 
the Actions menu. The RFQ Response number is saved in the Bookmarks list in the navigation pane 
on the left side of the Agile Web Client page. 

You can delete bookmarks you no longer need. 

To delete a bookmark: 

1. Click the Organize Bookmarks icon in the My Bookmarks folder in the left pane. 
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2. If the bookmark you want to delete is in a bookmark subfolder, navigate to that folder. 

3. Select the row(s) of the bookmark(s) you want to delete. 

4. Click Remove. 

5. Click Save. 
 

Sending RFQ Responses 

You can send any Agile PLM object to another user listed in the Agile PLM address book, if you 
(and the other user) have the appropriate send privilege for the object type. The user receives an 
email that contains a link to the object. The recipient can then click the link to view the object in 
Agile PLM. 

Note When you send an RFQ Response, the ownership of the RFQ Response is not changed. 
If you want to transfer ownership of an RFQ Response to another user in your supplier 
organization, use the Forward action, described in Forwarding RFQ Responses on page 
37. 

 To send an RFQ Response: 

1. Open an RFQ Response. 

2. Choose Actions > Send. The Send dialog appears. 

3. Click the  button next to the Notify field to find and select the users or groups to whom you 
want to send the RFQ Response. 

4. Enter comments, as needed. Your comments are included in the body of the message. 

5. Click Send. 

Note Click the Send notification as urgent checkbox to set the notification message's priority 
flag to High. 

 

Forwarding RFQ Responses 

You can forward an RFQ Response to another user in your supplier company. This is helpful when 
several people are involved in answering and returning a response to the buyer. 

Once you forward a response, you can no longer edit it, but you can still view it. Also, if needed, the 
person you forward the RFQ Response to can forward it back to you. When an RFQ Response is 
forwarded, the initial supplier contact user remains the primary contact. If the buyer modifies the 
RFQ Response in any way, it automatically reverts to the initial supplier contact and disappears 
from the second contact user‘s workflow routings. You can specify a comment to accompany the 
notification when forwarding a response. 

Note It is recommended that when using RFQ Forward, the additional Contact Users‘ Preferred 
Inbox View be set to Notifications. This will allow the user to view any instructions that may 
be included in the body of each notification. 
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To forward an RFQ Response: 

1. Open an RFQ Response. 

2. Choose Actions > Forward. The Forward Response dialog appears. 

3. Select the user to whom you want to forward the RFQ Response in the Notify dropdown list. 
The list includes the contact users related to the organization. 

4. Enter comments, as needed. 

5. Click Send. 

Important If the RFQ has Terms and Conditions associated with it, any supplier user who opens 
up the forwarded RFQ is required to accept the terms in order to open the RFQ. A 
record of forwarding is maintained on the History tab. 

As an alternative, you may choose to have users work in parallel, instead of waiting for the RFQ 
Response to be forwarded along. To allow users to work in parallel, see Authorized Users on page 
38. 

Authorized Users 

An authorized user is a user within your organization who is authorized to work with a particular 
object. For example, you can select one or more authorized users for an RFQ Response. 
Authorized users can work on the RFQ Response in parallel. Alternatively, if you want the 
authorized users to work in sequential order, one authorized user can work on an RFQ Response 
and then forward it to the next user when they are done.  

To add an authorized user to an RFQ Response: 

1. Open an RFQ Response. 

2. Click Edit on the CoverPage tab. 

3. Type in the users you want to add or click the  next to the Authorized Suppliers field to 
search. 

4. Click Save once you have added the suppliers. 
 

Completing RFQ Responses 
The sourcing manager in a buyer organization sends a request for quotes (RFQ) to your company. 
The RFQ responder receives the request and provides a response to the requester. The responder 
becomes the owner of an RFQ Response object. You can access an RFQ Response in two ways: 

 From the Notifications tab in your Inbox — You receive notifications about subscriptions or 
completed processes and requests to accept ownership of an action item or activity. Click the 
new notification message. Click the RFQ number on the Notifications & Requests page to open 
the RFQ Response object. 

 From RFQ Response searches — Search for RFQ Responses. On the search results page, 
click the RFQ number you want. 

The Cover Page tab of an RFQ Response displays general information about that RFQ Response. 
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Review the Cover Page for information such as the response due date, instructions, contact 
information, who owns the RFQ Response in your organization, percent of progress, and lifecycle 
phase. 

Using the Responses Tab to Respond to RFQs 

Note Whether or not you can view the Responses tab of an RFQ Response object depends on 
the Response Edit Mode selected on the Preferences tab of your user profile. If the 
Response Edit Mode is set to Basic, you will not see any tabs when you open the RFQ 
Response. For information about changing your Response Edit Mode, see RFQ 

Response Edit Mode on page 12. 

The Responses tab is where you do most of your work. You can check the RFQ item responses, 
negotiate prices and terms, and submit bids to the buyer. 

Note In Basic response edit mode, you can do these things on the Response page, which is 
accessed by clicking the View Line Items link in the left pane. 

In order to see the supplier‘s view of an RFQ, you must log in to Agile PLM as the user who is the 
supplier‘s contact person with RFQ response permissions. 

Responses Tab 

When you click the Responses tab, you can view the responses to the RFQ in the response table. 
The columns displayed on the Responses tab can vary in different RFQs, depending on how the 
sourcing manager decides to create each RFQ. The fields selected by the sourcing manager will 
show up as columns in the table on the response tab. 

Responses Table 

In addition to non-material and material price fields for each price scenario (quantity break or price 
period), the Responses tab includes at least the following fields: 

AML Status  The status of the manufacturer part for the item, for example, whether the manufacturer 
part is the preferred part or the alternate part. 

Number  The part number for the item listed. Manufacturer part numbers (MPNs) are indented under 
associated internal part numbers (IPNs). If the buyer has opted to not share IPNs, you are 
notified, and you cannot view the BOM. If an IPN leaf level or assembly does not have an 
associated AML, or if the buyer sets the quote level at an assembly level without an AML, 
the IPN appears. 

Rev  The revision of the item. 

Description  The description of the item. 

Manufacturer  The name of the manufacturer for the MPN. 

Commodity  The commodity name, for example, ICs, Resistors, or Diodes. 

Bid Decision The decision to bid or not bid, and the reason for not bidding. 

UOM  Displays the quantity unit of measure. 
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To view an object listed on the Responses tab, click its number. 
 

Responses dropdown Lists 

The three action buttons that are available on the RFQ Response Responses tab are: 

 Responses — You can to choose Enter/modify, Bulk Edit Expiration Dates, or Submit an RFQ 
Response. You can also Propose Alternate Parts, Delete Alternate Parts, or Lookup Prices.  

 View — View Costed Bill of Materials or view Bill of Materials Structures. 

 More — Fill-up, Fill down, Fill-up (selected cells), Fill down (selected cells), Export, and Import 
content.   

Optional Buttons 

These buttons are optional and configurable in the ―data to share with suppliers‖ section in the RFQ 
(or the associated sourcing project). Adjacent to the Responses drop down lists, there are two 
optional buttons: 

Costed BOM — Limited view of BOM items and prices; only part of the BOM is actually quoted to this 
supplier. Parts in the hierarchy that have not been requested for quotes are not displayed. 

Content BOM — View of a BOM and each item‘s children parts. If an assembly is quoted as a 
Component/Custom Component, the BOM tree underneath the assembly does not appear in the 
Costed BOM view, but is visible in the BOM Content view. 

Note These buttons can not be added once the RFQ has been opened to suppliers. 

 

Response Line Lifecycle Status 

In addition to the RFQ Response object lifecycle phase, each response line has its own unique 
lifecycle status. This allows each response line item to be managed and tracked separately.  

The following table lists symbols related to RFQ response lines. These symbols are displayed for 
each line on the Responses tab. 

Symbol  Represents  Descr ipt ion  

 
Pending This icon indicates that the response information for the item 

has not yet been submitted. 

 Ready This icon indicates that all requested response information 
has been entered for the item and is ready to be submitted. 

 
Invalid This icon indicates that some requested response 

information has not been entered for the item (or has been 
entered incorrectly); more information is needed. 

In the Advanced Wizard and Basic edit modes only, when 
you click this icon, the response goes into edit mode and 

fields that need attention are indicated by .  
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Symbol  Represents  Descr ipt ion  

 Submitted This icon indicates that the response for this item has been 
submitted. 

 Error This icon indicates that a field is invalid and needs to be 
fixed. 

 Locked This icon indicates that you cannot make any changes to the 
response line; the response line is locked. 

 Requote This icon appears for the items that are sent to you for a 
requote. 

 
Details This icon marks the Price Details (Has Price Information) 

column. If a line item has  in this column, it means that it 
has price information available for it. You can click the dot 
icon to view the response price details for the item. 

 Supplier Proposed This icon indicates that this is an alternate manufacturer part 
that you proposed. 

 Quantity Changed or New 
Line Added 

The buyer has changed quantities or added a new line to the 
response since it was submitted. 

 
View Response Changes Click this icon to view the history of the changes that have 

been made to the response for this item. 

 
 

RFQ Price Scenarios 

When you first display the Responses tab, the information appears according to the default price 
scenario. You can select another type of price scenario from the Price Scenarios dropdown list. 

 All Price Scenarios — View all price scenarios associated with the response. 

 Default Price Scenario — View the default price scenario associated with the response. The 
default is defined as the lowest quantity break of the effectivity period that falls within today‘s 
date, or the earliest effectivity period. 

 Selected Price Scenarios — Select from a list of price scenarios. 

To view information for a selected price scenario: 

1. Open an RFQ Response, and go to Responses tab. 

2. In the Price Scenarios dropdown list, select Selected Price Scenario. In the window that appears, 
select the price scenarios you want to show from the Hidden Fields list. Click the right arrow to 
add them to the Displayed Fields list. 

3. Click OK. 

Each price scenario represents either one quantity break or one quantity per price period. The 
following table shows examples of quantity breaks and target prices for one period for several 
different items. 
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I tem number  10 /01 /04  -  12/31 /04   
Quant i tyBreak1  -  

Quant i ty  

10 /01 /04  -  12/31 /04   
Quant i tyBreak1  -  Target  Pr ice  

10-007 1 0.04 

10-008 10 12.80 

10-009 1 0.04 

10-010 10 16.60 

10-011 1 0.04 

10-012 1 0.09 

10-013 5 2.95 

10-014 100 122.00 

Note To set a price value to 0, you must explicitly enter 0. 

The Agile PLM system supports different price scenarios, so RFQ response fields vary based on 
the price periods and quantity breaks specified for a particular RFQ. Prices can be based on 
multiple quantity breaks (up to 6) or on multiple price periods, with one or more quantities per price 
period. 

Pre-defined Views 

The pre-defined filters available on the Responses tab are as follows: 

 Items Need Response - Identifies those parts for which the supplier has to provide prices or 
update prices (in case of requotes) and resubmit. 

 Items With Split - Displays items whose AML have AML splits. 

 Preferred AML - Displays items that have AML where the status is set to "preferred". 

You can also personalize the view of the Responses tab, as well as other tabs, using the Table 
Personalization palette. For more information, see Personalizing PCM Object Tabs. 

Entering and Modifying RFQ Response Information 

There are two basic ways to enter your response information into PCM: 

 Online — Enter the information online in the Agile Web Client. For details, see Creating Online 
Responses. 

 Offline — Export the selected response lines of the Responses tab to a file, edit the exported file 
in a spreadsheet program, such as Microsoft Excel, and then import the edited file, with your 
data, into Agile PLM. For details, see Creating Offline Responses on page 49. 

 

Creating Online Responses 
When you receive an RFQ notification email and click the URL link to access the Product Cost 
Management system, you are taken automatically to the Cover Page of that new RFQ. Once there, 
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if your preferred Response Edit Mode is set to Basic, you can click any step in the process flow list 
to move to that corresponding page. The step you select is highlighted in the left pane, so that you 
can tell where you are in the process. Otherwise, if you are not using Basic response edit mode, 
click on individual tabs in the RFQ Response to create your online response. 

For more information on process flow, see About the RFQ Response Process Flow on page 34. 

Online Edit Methods 

You can enter response information online in any of the three following ways: 

 Advanced Table Edit 

 Advanced Wizard Edit 

 Basic Edit 

Specify the method you want to use on the Preferences tab in your user profile. For information 
about setting the Response Edit Mode preference, see RFQ Response Edit Mode on page 12. 

Advanced Table Edit 

In Advanced Table Edit mode, you can enter bids for multiple line items in a single view. You can 
enter responses directly in the fields on the Responses tab. 

Note In this edit mode, you must double-click the first field you want to enter, however, any 
following fields are made editable with just a single-click (or by using the Tab keys). 

To enter response information using the Advanced Table Edit method: 

Note Make sure your Response Edit Mode preference is set to Advanced Table Edit. For 
details, see RFQ Response Edit Mode on page 12. 

1. Open the RFQ Response that you want to work with, and go to Responses tab. 

2. Select a different bid decision from the Bid Decision dropdown list, if appropriate. 

3. For each quantity break, provide the material price and non-material price (if applicable). 

The edit function for Material and Non-material prices depends on the Quote As method set by 
the buyer: 

 Assembly - You can edit only the Non-material price. 

 Component - You can edit only the Material price. 

 Custom Component - You can edit both Material and Non-material prices. 

4. Enter or change the quantity in the Inventory Available field. 

5. Fill in the Valid From field, if appropriate. 

6. Change the expiration date in the Valid Until field, if appropriate. 

7. When you are finished, click Save, or click Cancel to return to the previous page without saving 
your entries. 
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Note A appears next to any line item that has not been correctly completed. Although 
all valid fields are saved to the database, you cannot submit a response to the 
sourcing manager until invalid required fields are completed.  

8. Once you save a valid response, the Ready symbol appears in the Response Readiness 
Status column. 

Note You can copy response data values from one cell to another. Select the value you want 
to copy and press Ctrl + C. Place the cursor on the destination cell, and press Ctrl + V to 
paste the copied value. Alternatively, you can click on More > Fill-down or More > Fill-up to 
copy the contents of one cell to the rows below or above it, respectively. 

 

Advanced Wizard Edit 

In Advanced Wizard Edit mode, you can enter your bid for a single line item at a time. You can also 
enter identical bids for all selected line items at one time. In this mode, all bids are entered via the 
Response Entry dialog, which is described in Response Entry Form. 

To enter response information using the Advanced Wizard Edit method: 

Note Make sure your Response Edit Mode preference is set to Advanced Wizard Edit. For 
details, see RFQ Response Edit Mode on page 12. 

1. Open the RFQ Response and go to Responses tab. 

2. Select the line item(s) that you want to work with, and choose Responses > Enter. The Response 
Entry dialog appears.  

3. Select a different bid decision from the Bid Decision dropdown list, if appropriate. 

4. Enter or change the quantity in the Inventory Available field. 

5. Fill in the Valid From field, if appropriate. 

6. Change the expiration date in the Valid Until field, if appropriate. 

7. For each quantity break, provide the material price and non-material price (if applicable). 

The edit function for Material and Non-material prices depends on the Quote As method set by 
the buyer: 

 Assembly - You can edit only the Non-material price. 

 Component - You can edit only the Material price. 

 Custom Component- You can edit both Material and Non-material prices. 

8. The Fill Right button  can save you time. If you want the same value to appear in every 
column to the right of where you are entering a value, click the Fill Right button. The value is 
copied into the column to the right. 

9. Click Next to save your entries and go on to the next item in the RFQ Response (if you selected 
more than one line item on which to bid). 

Note To apply your entries to all of the selected response lines, check the box labeled 
Apply to all the selected response lines and click Finish. 
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10. When you have finished entering or editing the information, click Finish. 

The Responses tab appears. The information you entered is included in the table. 

Note A appears next to any line item that has not been correctly completed. Although 
all valid fields are saved to the database, you cannot submit a response to the 
sourcing manager until invalid required fields are correctly completed. To complete 

an invalid entry, select the line item and then click the icon. The RFQ Response 

goes into edit/modify mode and any invalid fields are indicated by the  icon.  

 

Response Entry Form 

When in Advanced Wizard Edit and Basic edit mode, you edit responses using this dynamic entry 
form, which performs requisite calculations instantly. For example, when you fill a certain amount in 
Material Price field, and then change it to another amount, the Total Material Price figures change 
immediately. 

On this form there is an Apply to all the selected response lines checkbox. When you check this box, the 
data (Inventory Available, Material Price, Valid Until, etc.) that you fill in for the current item, is 
applied to all the other response lines that you selected for editing.   
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Basic Edit 

This method is similar to the Advanced Wizard Edit method, as described in Advanced Wizard Edit. 
When you open an RFQ, you only see the Cover Page. You do not see tabs in this mode. To 
display line items, you must click View Line Items in the list of process flow steps in the left pane. To 
display the Response Entry dialog, you must click Enter Responses in the left pane.  

Note A appears next to any line item that has not been correctly completed. Although all 
valid fields are saved to the database, you cannot submit a response to the sourcing 
manager until invalid required fields are completed. To complete an invalid entry, select 

the line item and then click the icon. The RFQ Response goes into edit/modify mode 

and any invalid fields are indicated by the  icon.  

 

Setting the Expiration Date 

You can specify an expiration date for each line of your response. 

Note This option is available only when the RFQ Response uses quantity breaks. This option 
is not available when the RFQ Response uses price periods. 

To set the expiration date: 

1. Select one or more line items in the RFQ Response Responses tab. 

2. Choose Responses > Bulk Edit Expiration Dates. The Set Expiration Date window appears. 

3. Enter the expiration date in the Date field, or select a date from the calendar. 

4. Click Set. 
 

Proposing an Alternate Manufacturer Part 

Suppliers are often requested to quote on parts they are unable to supply for various reasons. For 
example, the part may be obsolete or on allocation. You can suggest alternate parts in the RFQ 
Response. 

You can add alternate part information for one or more items in an RFQ Response. This alternate 
part information is visible to the sourcing project manager when you submit your responses. If you 
propose an alternate part, you can add attachments such as data sheets. 

To propose an alternate manufacturer part: 

1. On the Responses tab of the RFQ Response, select the parts for which you want to propose 
alternates. 

Note You can only propose alternates for items with an AML. 

2. Choose Responses > Propose Alternate Part. The Add Alternate Part dialog appears. 

3. Enter the alternate manufacturer part Number and Description. 

4. Click the button next to the Manufacturer list to search and select the part‘s manufacturer. 



 Chapter 4: Responding to Request for Quotes 

 

 

 47  

  

Click Continue.  

5. Fill up all the required information. 

6. Click Save. The added manufacturer part is identified by the  Supplier Proposed icon. 

Note If the proposed manufacturer is not currently in the Agile database, use the following 
workaround procedure. 

To propose an alternate manufacturer part for a manufacturer not in the Agile Database: 

1. Create a manufacturer and name it ―New". For more information on how to create a 
manufacturer, see Agile Product Cost Management User Guide. 

2. Follow steps 2 and 3 from the preceding procedure, To Propose an alternate manufacturer 
part. 

3. Click the button next to the Manufacturer list to search and select the part‘s manufacturer. 
(Enter ―New‖ in the search field.) 

4. Click Continue.  

5. Fill up all the required information. 

6. Click Save. The added manufacturer part is identified by the   Supplier Proposed icon. 
 

Adding an Attachment for an Alternate Part 

The process of adding an attachment for an alternate part is the same as adding an attachment for 
any Agile PLM object. 

To add an attachment: 

1. On the Responses tab, click on the number of the alternate part to which you want to add an 
attachment. The Quick View for the part appears. 

2. Click on the Attachments tab. 

3. Click Add > Files, Add > URLs (proceed to step 5), or Add > By Search (proceed to step 6). 

4. If you chose Add > Files, the Add File dialog appears. 

Note Before reaching the Add File dialog box, you may see a dialog box asking you to 
choose between the standard upload method or the advanced Java tool. If you 
select the Java upload tool, the following steps will be carried out in a Java based 
dialog box. Otherwise, you will be led to the standard HTML based file search and 
add window.  

 Once you decide on a type of method, select the "Do not show this dialog again" 
checkbox. 

a. In the Add File dialog window, use the Browse button to locate the files you want. 

b. A file folder containing the attached files is created automatically. To add the selected files 
in one file folder object, check the Add All Files to a Single File Folder checkbox. (If you do not 
use this checkbox, a file folder object is created for each file you have selected.) 

c. When you have selected the files you want, click Add in the dialog window. The file name 
and the newly created file folder object are listed in the Attachments table. 
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5. If you chose Add > URLs, the Add URLs dialog appears. 

a. Enter the URLs. (You can copy a URL from your browser and paste it here.) 

b. Click Preview to test each URL. 

c. To add the selected URLS in one folder object, check the Add All URLs to a Single File Folder 
checkbox. 

d. When you are through, click Add. The URLs and newly created file folder objects are listed 
in the Attachments table. 

6. If you chose Add > By Search, the Add Files window appears. 

a. Search for and select the file folder you want, then select files or URLs in that file folder 
that you want. 

7. To return to the Responses tab, click Close in the Quick View window. 
 

Deleting Proposed Alternate Parts 

You can delete alternate parts that you have proposed. 

To delete alternate parts: 

1. On the Responses tab, select the alternate part you want to remove.  

When you select an item, all its alternate parts are selected automatically. If an item has 
multiple alternate parts, you can select the item row itself and then go about deselecting the 
alternate parts you want to keep. 

2. Choose Responses > Delete Proposed Alternates. 
 

Looking up Prices 

You can verify the existence of a price scenario for a specified period and quantity in the Item 
Master.  

In Agile PCM, there are three types of prices: 

 Contracts — Predefined agreements for item prices over a specified time period. 

 Published Prices — Item price information that has been published from other projects to the 
Item Master. 

 Quote Histories — Quoted prices that were previously received for an item. 

When you look up data for a particular item or manufacturer part, the price and response fields are 
updated with data that you can leverage in your analysis process.  

Note You only have access to prices that are relevant to your organization. You will not be 
able to look up prices supplied by other suppliers. 

An item can have multiple types of prices. When you do a price lookup for an item, Agile PCM 
selects a price in the following order of preference: contracts, published prices, and quote histories. 

Looking Up Contracts, Published Prices, or Quote Histories 

You can look up contract prices, published prices, or quote histories. 
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Note Selection of the price details depends on the Look Up criteria mentioned. To break ties 
between prices, the deciding factor can be Lowest Price or Lead Time or Most recent 
response. 

To look up prices: 

1. Open a RFQ Response and select the Responses tab. 

2. Select the row(s) of the item for which you want to look up contract pricing information. 

3. Choose Responses > Price Lookup. The Price Lookup from Item Master dialog appears. 

4. Select a price scenario from the Base Scenario dropdown list. 

5. Click the   button next to the Price Types field. Select either Contract, Published Price, or Quote 
History or a user-defined price type. 

6. Decide whether to Populate Price to all scenarios or just one. 

Note Assume that an RFQ has two price scenarios, Q1 & Q2, and you want to look up 
prices for Q1. The system will try to find a price based on the base scenario, which 
is Q1.  If the All Price Scenarios option was selected, once the system finds a price, it 
will use the same price (Q1's price) for Q2 and update both scenarios with the same 
price. If just one scenario was chosen, only that one is updated. 

7. Enter the quantity deviation, in percentage, to search for in the Item Master if you select that 
option, or select the Ignore Quantities button to ignore the quantity. 

Note For example, if the quantity in an RFQ is 100 and a user gives a 10% deviation 
range, the system finds prices for the part that are within the quantity of 90 and 110. 

8. Enter the number of days from the RFQ date range, plus or minus, within which the quotes 
have been received or select the Ignore the date ranges button to ignore the date of quote. 

9. Select the Lowest Price, Shortest Lead time, or Most recent response button to filter the results if 
multiple rows are retrieved. 

Note For the Most recent response option to function accurately, the Agile administrator 
must have enabled the attribute Priceline.DateModified in the Java Client. By 
default, this attribute is disabled. To use this search option, the Agile administrator 
must enable the Priceline.DateModified attribute in the Java Client for the privilege 
(Restricted) Read my Organizations Prices under UserSettings > Privileges > Read.  

10. Optional 

You can narrow down your look up criterion across 

 a particular Ship To Location 

 specific Program(s)  

 specific Customer(s) 

11. Click Look Up. 
 

Creating Offline Responses 
You can export the items on the Responses tab to prepare a response. When you export items, Agile 
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PLM generates a Comma-delimited text (CSV) file or an Excel workbook. The exported response 
file is named RFQNumber.csv or RFQNumber.xls.  

You can use a spreadsheet program, such as Microsoft Excel, to edit a CSV file. You can also use 
a quoting tool to complete responses offline. After you complete the fields in a response file, you 
can import the file back into the Agile PLM system to submit the response to the sourcing manager. 

Exporting RFQ Response Lines 

You can export response lines to your local hard drive as a comma-delimited file (CSV) or Excel 
Workbook (XLS) file.  

To export response lines: 

1. Open the RFQ Response. 

2. Click the Responses tab. 

3. Click the row selection cells of the response line items you want to export (use the ctrl keyboard 
button to select multiple lines) or click the All Rows Selection cell to select all. 

4. Click More > Export (xls) or More > Export (csv). The File Download dialog appears. 

5. Save the file to the desired location.  

For more details, see the Import/Export User Guide. 

Editing Supplier Response Fields in Exported Supplier Response Files 

The exported supplier response file can be an Excel spreadsheet with a structured layout of RFQ 
header information and supplier response fields. The RFQ header rows are collapsible, while row 
and column headings are frozen panes that enable ease-of-reference to off-view fields. 

As shown below in the spreadsheet example, a color legend is used to indicate more information 
about a field. The following legend is used: 

 Required fields are shaded yellow, with bold headings and ‗must be‘ filled for the response 
acceptance.  

 Requested fields are also shaded yellow, however, they have normal headings and are 
optional.  
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 Gray shaded fields should not be filled at all, while the white shaded fields are informational. 

 

To successfully import a supplier response text file, you must follow these guidelines when you edit 
the file: 

 You can reorder column headings, but do not edit or add any data to the headings. If you 
modify column headings, the file cannot be imported. 

 Do not add new columns of data. 

 Do not modify any date fields except for EOL Date and Expiration Date. 

Important If you fail to complete all required fields, you can still successfully import the file. 
However, you won‘t be able to submit the responses to the sourcing manager. 
Required and requested fields are specified by the sourcing manager who set 
up the project and RFQ. 

 Empty fields are not imported. They are not equal to 0. To set a numeric field or a price field to 
0, you must explicitly enter the value 0. 

 If you prefer, you can remove the <HEADER> section at the top of the file since it is not 
imported. To remove this section, make sure you remove the two rows containing the 
<HEADER> and </HEADER> tags and all rows in between. 

 When you import the supplier response file, the imported data replaces existing response field 
data. 

When you edit a supplier response file, make sure you edit only fields you are allowed to edit. 
Generally, this means the columns from Bid Decision to Material Price, inclusive. Other fields are for 
viewing only. 

You can import the supplier response file multiple times. Each time you import the file, only the 
editable fields are imported, replacing the previous values. The fields that appear in a supplier 
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response file depend on whether the sourcing manager specified them as requested and required. 

Valid Values for Supplier Response Fields 

Certain supplier response fields require specific values that must be spelled correctly. If you type an 
invalid value in the field, it won‘t be imported. The following table shows the valid values for the 
supplier response fields that require specific values. 

Note The header for the supplier response file also lists values for these fields. 

 

Field  Val id  va lues  Note  

Bid Decision Bid 
Bid - Alternate Part 
No Bid - Non-Franchise 
No Bid - Obsolete Part 
No Bid - On Allocation 
No Bid - Other 
No Bid - Unknown Part 
Not Responded 

 

Country of Origin  Enter a valid country name. Make sure the spelling is 
correct. 

NCNR Yes, No Non-Cancellable Non-Returnable 

Terms of Sale CFR Cost and Freight 

 CIF Cost, Insurance, and Freight 

 CIP Carriage and Insurance Paid To 

 CPT Carriage Paid To 

 DAF Delivered at Frontier 

 DDP Delivered Duty Paid 

 DDU Delivered Duty Unpaid 

 DEQ Delivered Ex Quay (Duty Paid) 

 DES Delivered Ex Ship 

 EXW Ex Works 

 FAS Free Alongside Ship 

 FCA Free Carrier 

 FOB Free on Board Vessel 

Note In addition to the three-letter abbreviations for Terms of Sale, you can enter the full 
Terms of Sale value, for example, ―CFR - COST AND FREIGHT‖ or ―CIF - COST, 
INSURANCE AND FREIGHT.‖ The value must be all uppercase. 
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Importing Previously Exported RFQ Response Files 

Unlike other types of objects that you can import, supplier responses do not require that you map 
import fields to PCM fields. Since the response is a modified version of the exported text file, the 
mapping is automatic. 

To import a RFQ Response file: 

1. Select and open the RFQ Response you want to work with. 

2. Click the Responses tab. 

3. Choose More > Import. The Import dialog appears. 

4. Click Browse; select the file you want to import. 

5. Select the appropriate configuration options. 

Note If you are importing a CSV file, you must select the same encoding type used to 
export the file. 

6. Click Import. 
 

Viewing BOM Attachments 
To view items that are custom components with attached critical documents, use the Content BOM 
view to expand item attachments to the BOM. This feature needs to be setup by the author of the 
RFQ. For more information on setting up and enabling suppliers to view the Content BOM, contact 
the Agile administrator. 

Note Some custom components have critical information attached such as Test Specifications 
and Packaging Specifications that could influence the cost that suppliers will bid. 

 

Costed BOM View 

A Costed BOM view shows your bids on each item and the rolled up cost for the assembly. 

Note The Costed BOM button that displays the Costed BOM view is available if your supplier 
organization is designated as a partner for the sourcing project or if the buyer has 
explicitly shared the BOM in order for you to see it. 

To use the Costed BOM View: 

1. Open the RFQ Response. 

2. Go to the Responses tab. 

3. Click View > Costed Bill of Materials. 

4. To view a specific price scenario: 

a. Select Selected Price Scenario in the Price Scenarios dropdown list. The Price Scenarios dialog 
box appears. 

b. Select the price scenario information from the Available Values, and then click right arrow 
to add to the Selected Values list. 
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c. Click OK. 

5. To return to the Responses tab, click Back. 
 

Content BOM View 

The Content BOM view will be available on the RFQ Response‘s Responses tab if configured in the 
project or RFQ as ―data to share with suppliers.‖ 

With the Content BOM option available, it permits children nodes in the BOM to show up in the 
supplier‘s view. This can be very helpful if some of the BOM‘s nested items are documents that 
would influence the supplier‘s cost bid. Some documents like Test Specs and Packaging Specs will 
be available in the Content BOM page. 

To access the Content BOM view: 

1. Login as the contact person of the supplier, and open the RFQ. 

2. Go to the Responses tab. 

3. Click View > Bill of Materials Structures. 

4. The Bill of Materials Structures page opens, so that you can see all of the BOM items and children 
nodes, including important documents. 

 

Assembly Cost Report 

The Assembly Cost (Supplier Response) report shows the costs at each level of the BOM structure 
for one or more top-level assemblies. The results of the Supplier Assembly Cost report mirror what 
the sourcing manager sees.  

Note The Assembly Cost report is not available in Basic edit mode. 

The following task provides a simple guideline to running and viewing the Assembly Cost (Supplier 
Response) report. For more information about working with reports, see the Agile Reports section of 
Getting Started with Agile PLM. 

To run the Assembly Cost (Supplier Response) report: 

1. In the navigation pane on the left, click the button that opens the Reports Folders. 

2. Go to Standard Reports > Sourcing Reports. 

3. Click Assembly Cost (Supplier Response). The tabbed report object page appears in the right pane. 

4. To run a report, click the Execute button. The report wizard page appears. 

5. In the Select Layout and Configuration step, select Default Layout from Layout type dropdown 
list. Click Next. 

6. In the Select Response step, select the RFQ Response you want to use from the dropdown list. 
Click Next. 

Note In order for an RFQ to appear as an option in this step, the buyer must have 
included "Costed BOM View" as ―data to share with suppliers.‖ 

7. In the Select Items step, click   next to the Assembly Lines field to choose the assembly lines 
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(BOMs) you want. Select an assembly line by double-clicking the desired row or by dragging 
selected table rows to the Assembly Lines cell on the Select Items wizard page. 

8. Click   next to the Price Scenarios field to choose the price scenarios you want in the report. 
Your choices are outlined below. Select a price scenario by double-clicking the desired row or 
by dragging selected table rows to the Price Scenarios cell on the Select Items wizard page. 

9. When you have completed the Select Items wizard step, click Finish to run the report. 

The report is generated and displayed in a separate window. You can use the buttons in the 
window to print, export, or save the report. Saved reports can be viewed on the Historical Reports 
tab of the tabbed report object page. For more information about working with reports, see 
Getting Started with Agile PLM. 

Submitting Responses 

You can make changes and resubmit RFQ response lines anytime, and as many times as you wish, 
until the response line is closed by the sourcing manager. 

The system shows you which lines are incomplete. When lines have incomplete information, they 

appear on the Responses tab with an icon in the Supplier Response Status column to the left of the 
item number. 

To fill in an incomplete response line: 

1. Click the in the Response Line Status column to the left of the item number. In Basic and 
Advanced Wizard Edit mode, the Response Entry dialog for the item appears. The invalid fields 

are indicated by the  icon. For details, see RFQ Response Edit Mode on page 12. 

2. Modify the invalid fields. 

3. When you are finished, click Finish. 

When you have finished entering or modifying response lines, you can submit the response. 

To submit a line item: 

1. Select one or more RFQ response lines on the Responses tab. If you‘re using the Basic method, 
all items are automatically selected. 

2. Click Responses > Submit. If there are lines with incomplete information, an error message 
appears on the Responses tab. The completed lines are immediately submitted to the sourcing 
manager. The invalid or incomplete lines are not submitted. 

To submit the complete RFQ: 

1. Click Actions > Submit (or the Submit button in Basic response edit mode) to submit a complete 
RFQ Response. Any response lines that are eligible for submittal will be sent to the buyer. 

 

Reviewing RFQ Response Changes 
The Changes tab of an RFQ Response allows you to review RFQ content changes or modifications 
made by the sourcing manager. 

You can see the RFQ line items that have been added or deleted by clicking the Project Item Changes 
sub-tab. You can use the Views dropdown to see only the items that have been added, deleted, or 
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modified. 

You can see changes in response lines by clicking the Supplier Response Changes sub-tab, and then 
clicking the Response Changes icon at the item level. 

Reviewing Changes to Response Lines 

After you create responses, you can review them to ensure that all response line items are 
complete and correct. You can filter the response lines to show only the lines you want to view. The 
most useful filter options are Decision, which displays the line item details by the bid decision, and 
Response Status. The RFQ Response lines with a decision of BID are validated to ensure that all 
required fields have been filled in. Even if you fill in part of the information, the sourcing project 
manager will not see a line item that is not filled out completely. 

Once the sourcing project manager closes a response line, it can no longer be submitted to the 
buyer. 

On the Responses tab of the RFQ Response object, click the View Response Changes icon  in 
the Response Changes column to view changes you have made to the response information for 
that item. 

The price details column is indicated by . Click the  in the Has Price Information column of the 
response table to view details about the response line. 

Changing Submitted Responses 

If you have the appropriate privileges, you can make changes to submitted line items. Usually, you 
cannot make changes if the line item or RFQ status is locked or closed. See Entering and 

Modifying RFQ Response Information on page 42. You cannot submit responses if the RFQ status 
is locked or closed. 

Occasionally, a supplier manager modifies an RFQ Response as a result of the following: 

 Data correction requirements 

 Due date changes 

 Addition of new RFQ line items 

 Request for requote 

You receive notifications, according to notification settings, about changes that have been 
performed. You can display the Changes tab of an RFQ Response to view the changes. Also, 

response lines that have been modified or recently added by the buyer are indicated by a  in the 
Response Readiness Status column on the Responses tab.  

Based on the type of change, you might need to complete a new response line, provide a requote 
for an existing line item, or provide additional data. 

Using Discussions 
When you are negotiating with the buyers who send you requests for quotes, you often need to 
have informal, threaded dialogue to share information and to finalize quotes. You can also carry on 
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discussions with other users in your organization. You can reply to messages and add and remove 
discussions. 

Discussions replace the conventional email messaging service. Like email, discussions have a 
subject line, message area, priority, and a notification list. You can reply to the discussion as you 
reply to an email. Recipients receive the discussion as a notification in their inbox. Only Agile PLM 
users can participate in discussions. 

Adding a Discussion 

You can add discussions based on different subjects. 

To create and add discussions: 

1. Open the RFQ Response and select the Discussion tab. 

2. Click Add. A new row appears in the Discussions table. 

3. Click the  button. The Create New dialog appears. 

Note You can also add an existing discussion by clicking the  button and searching for 
it. 

4. Select the type of discussion from the Discussion Type field 

5. Enter the subject in the Subject field. 

6. Enter discussion text in the Message field. 

7. Select the priority of the message from the Priority dropdown list. 

8. Click the  button next to the Notify List field, and select the names of recipients. 

9. Click Add. A notification is sent to the users in the Notify List. 
 

Replying to a Discussion 

You can reply to discussions in which you are included. Replying to a discussion is similar to 
replying to an email. You can find the discussion notification in your inbox. You need to have the 
(Restricted) Discussion Participant role assigned to you to reply to a discussion. 

You can access a discussion by clicking on the Discussion tab of the RFQ Response that is 
associated to the discussion. Alternatively, you can access the discussion from your Notifications 
inbox. From within your inbox, click the subject in the Regarding column to open the discussion.  

To reply to discussions: 

1. On the Discussion tab of the discussion object, click Reply. The Reply to Discussion dialog 
appears. 

2. Enter the reply in the Message field. 

3. To change the list of recipients, click the   button next to the Notify List field. Select the 
names of recipients. 

4. Click Send. 
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Note You can send any number of replies in a discussion. 

 

Removing Discussions 

After you finish all your discussions, you can remove them from the Discussions tab of the RFQ 
Response object. 

To remove discussions from the Discussions tab of an RFQ Response object: 

1. Open the RFQ Response and click the Discussions tab. 

2. Select the row of the discussion you want to remove. 

3. Click Remove on the Discussions tab. 

Note The child discussion lines are deleted if parent is deleted. 
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Chapter 5 

Collaborating on Pricing and Contract 
Information 

This chapter includes the following: 

 About Prices ........................................................................................................................................................ 59 
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 About Price Change Orders ................................................................................................................................. 65 
 Creating PCOs ..................................................................................................................................................... 66 
 Workflow Tab ....................................................................................................................................................... 73 
 User Action Timestamp ....................................................................................................................................... 74 

 
 

About Prices 
The Agile PLM system can store information about different prices for different items. Users in 
departments throughout the buyer organization can access this information to use in finalizing the 
prices for an item or manufacturer part. 

The process of managing prices involves three entities: 

 Price — This is where you record the prices for items or manufacturer parts. A price object can 
have multiple price lines. You can add it to any PCO without having to create a new PCO. 

 Price Line — Price lines contain the core price information about an item or manufacturer part, 
which is unique by quantity, ship-to location, and effectivity period. You can create any number 
of price lines within a price object, but they should be uniquely identified. Price lines have the 
general information of the price object. A Price object may have multiple Price Lines, because 
several of the price and terms attributes are dependent on the context (for example, Ship-To 
Location). 

 Price Change Order (PCO) — A price change order is the route for revising or deleting the price 
information about an object. A price change order follows a workflow from the Preliminary 
through the Signoff phase. A PCO can have multiple price objects, and a price can be added to 
any existing PCO. 

If you have the (Restricted) Price Collaborator role, you can participate in the price management 
process, including creating price objects, creating and submitting PCOs, modifying price lines, and 
approving PCOs 

An item can have many revisions due to content change, manufacturing change orders, engineering 
change orders, and so on. Each change is called a revision. All the price lines associated with the 
price object are for the specified revision of the item only. 

Note You can personalize the view on some Price object tabs. To learn more about the 
personalization features, see Personalizing PCM Object Tabs. 
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Creating Prices 
Agile users with the appropriate privileges can create or modify a price object. You can create a 
price in the following ways: 

 From the Create New menu. 

As a supplier user, this is the method you will use to create price objects. This is the method 
discussed in this manual. 

 Using the Import command. 

For more information about using the Import command, see Getting Started with Agile PLM. 

 Using the Actions menu in an item or manufacturer part. 

You must have Read privilege for the Item object or Manufacturer Part object to create a price 
from the Actions menu. 

To create a price from the Create New menu: 

1. Choose Create New > Prices > Published Price. The Create Published Prices dialog appears. 

2. Select a price type from the Type dropdown list. Once you select a price type, additional fields 
appear on the dialog page. 

3. A unique, system generated number may be automatically filled in the Number field on the basis 
of Price Type you selected. Based on the settings defined by your Agile administrator, you may 

be able to modify this number, give one of your own, or click  to generate a new number.  

4. Select the Part Type (Item or Manufacturer Part) from the dropdown list.  

5. Click  button to search and select an item or manufacturer part from Search Object palette. 
It fills up the field with corresponding part number. 

If you selected Item from Item/Manufacturer Part list, a Rev dropdown list appears for you to select 
its Revision, for example, Introductory. 

If you selected Manufacturer Part in Item/Manufacturer Part list, the Rev dropdown list does not 
appear as its revision is not in your control. 

6. Select the Manufacturing Site from the dropdown list. 

If a manufacturing site is selected, the item price information applies to the items or 
manufacturer parts manufactured only at that site. If the field is left blank, the price information 
applies to the item or manufacturer part regardless of their manufacturing site. 

7. Click  button to search and select Suppliers through Identify Suppliers palettes.   

Note Only your supplier organization will be listed in the search results. 

8. Optional: Select a Program from its dropdown list. 

If a program is selected, the item price information applies only to that program. If All is 
selected, then the item price information applies to all programs. 

9. Optional: Select a Customer from its dropdown list. 

If a customer is selected, the item price information applies only to that customer. If All is 
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selected, the item price information applies to all the customers. 

10. Click Save. The new price's cover page appears. 

11. To add a new price line, go to the Price Lines tab. For more information about adding price 
lines, see Adding Price Lines on page 64. 

12. To add a new attachment, go to the Attachments tab. 
 

General Information Tab 

The General Information tab has fields that contain the general information about the price. It includes 
the following fields: 

Field  Edi table?  Descr ipt ion  

Mfr. Part Number (or Item 
Number) 

No The unique identification number of the manufacturer part (or item) 
for which the price is intended. 

Mfr. Name No The name of the manufacturer. 

 

Mfr. Part Number  (or 
Item Rev) 

No The unique identification number of the manufacturer part or 
revision number of the item for which the price is intended. 

Mfr. Name No The name of the manufacturer. 

Supplier  No The supplier of the item. 

Price Type No The type (subclass) of the price object. The default types are 
Contract, Published Price, and Quote History. The Agile 
administrator can rename the price types or create additional price 
types. 

Number No The unique identification number of the price object. 

Description Yes The description of the price object. 

Lifecycle Phase No The lifecycle phase of the price. 

Version No The version of the price. 

Allow Qty Breaks Yes A flag indicating whether the price information applies to quantity 
breaks or not. 

Owner Yes The user responsible for the price information. 

Customer No The customer to which the price information applies. If customer is 
not specified, the price information applies to all customers. 

Program No The program for which the price information applies. If program is 
not specified, the price information applies to all programs. 

Manufacturing Site No The site where the item is being manufactured. The price 
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information applies only to the item manufactured at that site. 

Authorized Suppliers Yes The suppliers that are authorized to view/read this price. 

Part EOL Date Yes The end of life date of the item. 

Min Yes The minimum quantity for which the price information applies. 

Mult Yes Indicates that the packaging delivers the item in multiple units; this 
value states how many are in each package. 

NCNR Yes The Non Cancelable Non Returnable flag for the item. 

Inventory Yes The available inventory. 

Version Release Date No The date the price was released. 

Effectivity Date  No The date the price information comes into effect. 

Contract Number No The number of the associated contract. 

Flex fields  Yes/No The other flex fields that are visible only if defined by your system 
administrator. 

To edit the information, click the Edit button. 
 

Changes Tab 

The Changes tab displays pending and historical changes that affect the price. Agile automatically 
fills in the information on this tab. The changes listed are those that apply to the revision specified in 
the Rev field at the top of the page. 

 Pending Changes Table 

The Pending Changes table displays any unreleased PCOs in which the given price is listed on 
the Affected Prices tab. You can click the link to a pending change to see what it proposes. 

 Changes History Table 

The Change History table displays any released PCOs where the price is listed on the Affected 
Prices tab. You can click the link to a released PCO to see what it contains and what price 
changes were made. 

To open a change listed on the Changes tab, click its number. The change opens with the Cover Page 
tab on top. 

Note Although its name is similar, the History tab shows actions taken on a price, while the 
tables on the Changes tab list released and pending changes for the price. 

 

Price Lines Tab 

A Price is an object where you record the price and terms conditions of items and manufacturer 
parts with relation to the supplier, customer, program, and manufacturing site. A price line is a 
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unique combination of ship-to location, ship-from location, effective-from date, effective-to date, and 
quantity that applies to a price. A price can have multiple price lines, based on specific contexts. 

The Price Lines tab includes the following fields: 

Required Fields  

Price Effective From Date The date the price takes effect. 

Currency Code  The unique identification code for the currency. 

Ship From  The place the item/manufacturer part is shipped from. 

Optional   

Ship To  The place the item/manufacturer part will be shipped to. 

Price Effective To Date The date the price no longer applies. 

Qty  The quantity (in its own unit of measure) for which the price applies. This field must be 
filled if the price is set to allow quantity breaks. 

Conversion Date The currency conversion date. 

Conversion Rate The rate at which the currency will be normalized to the project currency. 

Material Price  The per unit material cost of the item/manufacturer part. 

Non Recurring Cost  The one time cost which shall be applicable when the buyer first buys the item. 

Lead Time  The number of days required to supply the item/manufacturer part. 

Transportation Terms  The terms and conditions for transporting the item/manufacturer parts. 

Country of Origin  The country where the item/manufacturer part is manufactured. 

PriceLine Notes  Any specific information about the price line. 

Total Price The total price is the sum of Total Material Price and Total Non Material Price. Note: 
The total prices are calculated prices and are not user-editable 

Total Material Price The total material price of the item/manufacturer part. 

Total Non Material Price The cost of the item/manufacturer part not associated with materials, for example, 
labor rate, sales tax, and other over heads. 

Project Number The unique identification number of the project, if the price line is associated with the 
project. This field gets automatically populated if the price was published from a 
sourcing project. 

Overlapping price lines can occur when all or some of the effectivity periods of one price line fall 
within the effectivity periods of a second price line, and all other attributes are the same. 

The Agile administrator can configure the Agile system to disallow overlapping price lines. You can 
contact the sourcing manager or the Agile administrator to determine if overlapping price lines are 
allowed. 

Consider the following example: 

A buyer tries to create and save the following price lines. Note that the price lines have overlapping 
effectivity periods. 
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 Price L ine  1  Pr ice L ine  2  

Ship To Mumbai Mumbai 

Price Effective From Date 1st April 2009 5th April 2009 

Price Effective To Date 30th April 2009 25th April 2009 

Currency  INR INR 

Qty  2 2 

Material Price 10 9 

In the previous scenario, the system allows the user to save the price lines only if the Smart Rule, 
Overlap Price Line Effectivity Periods, is set to allow or warning. 

Additionally, it is important to remember that duplicate price lines are not allowed. For example, if a 
buyer tries to create and save the following price lines, the save will fail. 

 Price L ine  1  Pr ice L ine  2  

Ship To Mumbai Mumbai 

Price Effective From Date 5th April 2009 5th April 2009 

Price Effective To Date 30th April 2009 30th April 2009 

Currency  INR INR 

Qty  2 2 

Material Price 10 9 

In this case, since all of the required fields are the duplicated in both price lines, the save does not 
succeed even though the values for Material Price differ. 

Adding Price Lines 

You can add a price line if the price object is in the Preliminary lifecycle phase. If the price is 
associated with a PCO, you can add price lines through redline mode (if the PCO has not been 
released) or through a new PCO (if the PCO has been released). 

To add a price line, click Add on the Price Lines tab to display the Add Price Line dialog. Enter the 
price and terms information as required in the dialog. Note that although Ship-To, Price Effective 
From Date, and Currency Code are the only fields indicated as required, other fields such as 
Material Price and Qty (Quantity) are crucial to price lines, as well. Quantity, for example, must be 
filled if the price is set to allow quantity breaks. Once you are done filling in the price line 
information, click Finish to save the price line. 
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Removing Price Lines 

You can remove a price line if the price object is in the Preliminary lifecycle phase. If the price is 
associated with a PCO, you can remove price lines through redline mode (if the PCO has not been 
released) or through a new PCO (if the PCO has been released). 

To remove a price line, select the row(s) of the price line(s) and click Remove. 

Editing Price Lines 

You can edit a price line if the price object is in the Preliminary lifecycle phase. If the price is 
associated with a PCO, you can modify price lines through redline mode (if the PCO has not been 
released) or through a new PCO (if the PCO has been released). 

To edit a price line, click in the field you want to edit and make changes, as needed. Some fields 
may not be editable. 

Note For the first field you attempt to edit, you will have to double-click in it to make it editable. 
Any subsequent fields will only require a single-click to enable editing. 

While editing, you can edit multiple lines simultaneously by using the Fill-up and Fill-down options 
via the More button. For example, if you changed the Effective Date field for one price line, but wanted 
the same date for a few price lines below it, you can select the Effective Date cell for the price line 
that should be copied and the Effective Date cells of the price lines to which you want the value 
copied. When you click More > Fill-down (selected cells) the value that was in the first price line that 
you selected is copied to the selected cells below it. You could also use the Copy and Paste options 
via the More menu. Note that there are also keyboard shortcuts available for these editing options. 

Price Lifecycle Phases 

By default, price objects have the following lifecycle phases. The Agile administrator can rename 
lifecycle phases or create new lifecycle phases. 

 Preliminary 

 Active 

 Inactive 

 Obsolete 
 

About Price Change Orders 
You control any changes that need to be made to prices through a price change order (PCO). 
PCOs are routed through workflows, from the Pending phase through the Released phase. Through 
a PCO, you can release a price, redline the price information, and track the history of the price 
information. 

You create PCOs for price objects only. A PCO can include on its Affected Prices tab multiple prices 
that can be associated with different items, but a price object cannot be included on the Affected 
Prices tab of more than one pending PCO. 

The following table shows the tabs and the default fields for changes. The Agile administrator may 
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have added additional tabs, called Page Two and Page Three by default. These tabs contain custom 
fields defined by the administrator. The Relationships tab appears only if the Agile administrator has 
enabled them. 

Tab name Tab in format ion  inc ludes  

Cover Page General information about the PCO plus any unique fields defined by the Agile administrator. 
See Cover Page Tab on page 68. 

Affected Prices Which prices are affected by the PCO. PCOs include redlined price lines, and file folders 
(attachments). See Affected Prices Tab on page 70. 

Workflow Approvers, observers, and acknowledgers of the PCO and the results of their reviewing the 
PCO. 

For more information about working with routable objects and workflows, see the chapter 
about routing objects with workflows in Getting Started with Agile PLM. 

Relationships Lists objects that affect the status of the PCO and lists objects whose status is affected by 
the PCO. 

For more information about relationships, see the section about relationships and references 
between objects in Getting Started with Agile PLM.  

Attachments Lists the references to attached files and URLs contained in file folder objects.  

For more information about file folders and attachments, see the chapter about working with 
file folder objects and attachment files in Getting Started with Agile PLM. 

History All actions taken on the change. 

Note You can personalize the view on some Price Change Order object tabs. To learn more 
about the personalization features, see Personalizing PCM Object Tabs. 

Creating PCOs 
If you have the appropriate privileges, you can create or modify a PCO. This section describes two 
ways you can create a PCO: 

 From the Create New menu on the main menu bar 

 From the Actions menu on the Price page 

You can create PCOs from prices or from the Create menu on the main menu bar. When you create 
a PCO from a price (Actions > Add to Change), the price is associated with the PCO by default. When 
you create the PCO from the Create New menu, you must associate the price with the PCO 
manually. 

To create a PCO from the Create New menu: 

1. Click Create New  > Changes > Price Change Orders. The Create New Price Change Orders dialog 
appears. 

2. Select PCO Type from its dropdown list.  

3. Depending on how the Agile administrator has set up PCO numbering, a unique number may 
automatically be generated and inserted in the Number field. You may also be able to click 

 to get another system-generated number or enter your own number. 
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4. Click Save. The cover page of the newly created PCO appears. 

Note Fields are visible and/or editable based on how the buyer set up privileges for the 
supplier. 

5. Select a category from the Change Category dropdown list. 

6. Enter the Description of Change and the Reason for Change in the corresponding fields. 

7. Select a Reason Code, Workflow, and Price Admin from the corresponding dropdown lists.  

8. Click  next to the Originator.  It opens a search palette to find and select an originator from 
the list of users. By default, the originator is the user who creates the PCO. 

9. Change the Date Originated from the calendar to stamp the date of origination of the PCO, if it is 
different from today‘s date. 

10. Click  next to the Product Lines to select the affected product lines. 

11. Click Save.  The updated cover page appears. 

Add affected prices or attachments to the PCO by clicking on the corresponding tabs. 

To create a new PCO from a Price object: 

1. Open a Price object. 

2. Choose Actions > Add to Change > Create New. The Create Changes dialog appears. 

3. Select a PCO from the Change Type dropdown list. 

4. Depending on how the Agile administrator has set up PCO numbering, a unique number may 
automatically be generated and inserted in the Number field. You may also be able to click 

 to get another system-generated number or enter your own number. 

5. Click Save.  

6. To add details to the newly created PCO, follow steps 4 through 11 from the procedure To 
create a PCO from the Create New menu. 

After you create a PCO, the Cover Page tab appears with general information about the PCO. 

On the Attachments tab you can add references to files related to the PCO. For more information 
about attachments and file folders, see the chapter about working with file folder objects and 
attachment files in Getting Started with Agile PLM. 

You can view the log of actions that were taken on the PCO since it was created on the History tab. 
For more information, see Getting Started with Agile PLM. 

Adding the Current Price Object to an Existing PCO 

To add the current price object to the Affected Prices tab of an existing PCO: 

1. Open a price.  

2. Click Actions > Add to Change > Search. The search palette appears.  

3. Search for and select the PCO, to which you want to add the price, by double-clicking its row. 

 If the price was successfully added, the PCO page appears. The price object is listed in 
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Affected Prices tab of the PCO. If the price was not successfully added to the PCO, however, an 
error message appears in the information bar. 

Note You can also add prices to a PCO directly from within the Affected Prices tab of the PCO. 
For more information, see Adding Prices on page 71. 

 

Cover Page Tab 

The Cover Page tab shows the information traditionally shown on a paper PCO form. Agile completes 
some of the fields; you complete the rest. 

Buttons on the Cover Page Tab 

The Cover Page tab has the following buttons: 

 Edit — appears when the Cover Page is not in edit mode. To edit the Cover Page, click Edit. 

 Save — appears when the Cover Page is in edit mode. To save the changes that you made to 
the tab while it was in edit mode, click Save. 

 Cancel — appears when the Cover Page is in edit mode. To undo the changes that you made to 
the tab while it was in edit mode, click Cancel. 

 Validate Items — appears when the Cover Page is in edit mode. After you enter field values on 
the Cover Page, click this button to update the list of matching workflows available in the 
Workflow field. 

Sometimes you cannot edit a field. A field may be uneditable for two reasons: 

 The change has been released. 

 You do not have sufficient privileges or the appropriate license to modify that field. 
 

Fields on the Cover Page Tab 

The following table summarizes the Cover Page fields of the Price Change Order, how each field is 
completed, and what each field contains. 

The Cover Page can contain two additional sections, called Page Two and Page Three by default; the 
Agile administrator determines whether these sections are enabled, and what they are called. 

Field  How completed  Contents  

Number Automatically, when created. The number assigned to the change when 
you create it. 

Status Automatically, when created; updated 
as the change moves through the 
assigned workflow. 

Change status, described in the section 
“Status on the Cover Page Tab”; if no 
workflow has been selected, this field is 
Unassigned. 

Change Type Automatically, when created. The type (subclass) of change selected 
when you create the change. 

Change Category Usually manually; can contain a default. Drop-down list of categories defined by 
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Field  How completed  Contents  

the Agile administrator. 

Description Of 
Change 

Usually manually; can contain a default. A meaningful description of the PCO. 

Reason For 
Change 

Usually manually; can contain a default. The reason you are changing the price 
objects. 

Reason Code Usually automatically, when created 
(with the default set by the Agile 
administrator). 

Drop-down list of categories defined by 
the Agile administrator. 

Workflow Automatically (if only one workflow 
applies to the change), when the 
change is moved to the next status from 
the Unassigned status.  
If more than one workflow applies to the 
change, the workflow is selected 
manually; the workflow selection can be 
changed as long as the change is in the 
Pending status type. Selecting the blank 
field in the Workflow drop-down list 
switches the change to the Unassigned 
status. 

The name of the workflow being used to 
move this change through the change 
control process. 

Price Admin May be provided automatically by the 
workflow; otherwise selected manually 
from a drop-down list. User groups 
appear first in the list, followed by 
individual usernames. 

Default routing manager. 
If the workflow is defined to notify the 
default price administrator, the user group 
or user in this field receives notifications 
about the PCO. If this field is left blank, 
then the notifications are sent to every 
price administrator on the list. If the 
notification definition in the workflow is 
blank, no notifications are sent. 

Originator Usually automatically, when created 
(with the default set by the Agile 
administrator). 

The user who created the change (can be 
selected from a drop-down list). 

Date Originated Usually automatically, when created. The date the change was created. 

Date Released Automatically, when released. The date the change was released. 

Final Complete 
Date 

Automatically, when the change enters 
the Complete status type. 

The date the change moved into the 
Complete status type. 

Product Line(s) Usually manually; can contain a default. Drop-down list of categories defined by 
the Agile administrator. 

 
 

Status on the Cover Page Tab 

A ―stamp‖ in the top right corner of a change indicates the status of the change. The Agile 
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administrator defines the name of each status in each workflow. The workflow status is also listed in 
the Status field on the Cover Page tab. 

Note The Agile administrator may have created customized workflows and status stamps for 
your company. The table below lists only the Agile default workflow statuses for PCOs. 

 

Status stamp name  Status def in i t ion  

Unassigned 

(no status type) 

No workflow has been assigned to this change. The originator may still be 
developing the change. No statuses are displayed on the Workflow tab. 

Pending 

(Pending status type)  

The originator may still be developing the change. It has not yet been submitted 
to the price administrator. 

Submitted  

(Submit status type) 

The change has been routed to the price administrator for review and analysis. 

CCB 

(Review status type) 

The change has been routed to the members of the Change Control Board 
(CCB) for approval. 

Released  

(Released status type) 

The change has been signed off by the CCB members and released. 

Implemented 

(Complete status type) 

The PCO has been implemented or incorporated into new drawings. 

Hold  

(Hold status type) 

The change has been placed on hold while information is being gathered by the 
price administrator. 

Canceled  

(Cancel status type) 

The change has been cancelled due to a fundamental flaw or rejection by 
several people. 

The Workflow tab shows all the statuses the change has been through and the statuses remaining to 
complete the change control process. (See Workflow Tab on page 73) 

Affected Prices Tab 

Although the Agile administrator may have modified the Affected Prices table for PCOs, by default 
the table has the following columns: 

 Price Number — the number assigned to the price. 

 Price Description — the description of the price. 

 Item Number — the number assigned to the item associated with the price. 

 Item Rev — the revision of the item associated with the price. 

 Manufacturer Part Number — the number assigned to the part by the manufacturer. The 
manufacturer name and manufacturer part number comprise the unique identifier for the 
manufacturer part associated with the price. 
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 Mfr Name — the name of the manufacturer of the part associated with the price. 

 Old Lifecycle Phase — the lifecycle phase of the price before the change was released. 

 New Version — the revision (of the affected price) that will be created when the change is 
released. This field is automatically populated. 

 Effective Date — the date on which the change takes effect. 

 Lifecycle Phase — the lifecycle phase that the price will be in after the change is released. 

 Change Function — provides these choices: Interchangeable (new revision of a price that is 
compatible with the old revision), Non Functional (no change to a price, only to price 
documentation), and Release (new price). 

 Has been Redlined — indicates that there are redlines on the price line for that item. 

These additional columns are present for PCOs by default. These fields are filled in automatically. 

 Customer — the customer to whom this price applies.  If there is a customer assigned to the 
price, the price is available only for that customer and not for other customers. 

 Program — the program associated with this price object. ―All‖ is a valid entry. A program, for 
example, could be a group of BOMs that are managed together. The Agile administrator 
defines programs. 

 Supplier — the supplier of the item affected by the price object. In this case, it is your supplier 
organization. 

 Inventory — the number of units currently in inventory. 

 Min — the minimum number of units that can be purchased at one time. 

 Mult — if the units must be purchased as a package of multiple parts, the number of units in 
each package, for example a dozen, 50, or 100. 

 EOL Date — end of life date of the part. 

 Manufacturing Site — the manufacturing site (as defined by the sourcing organization) where 
the part will be used. 

 

Adding Prices 

To add a price to the Affected Prices tab: 

1. In the Affected Prices tab, click Add. A new row in the Affected Prices table appears. 

2. If known, type in the price number, otherwise you can click the  icon to search for an 
existing price. The search palette appears. 

Note Alternatively, you can click the  button to create a new price. 

3. From the search results, select the PCO you want to add by double-clicking the row.  

If the price can not be added, an error message appears. 

4. Close the search palette. The newly added price appears in the Affected Prices table. 
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Auto-populating Effective Date 

A price change order is used to modify the price of an item or manufacturer part. The affected price, 
however, does not come into effect until an Effective Date is defined. You can set this date either by 
editing prices selectively or by populating a common date to a number of price objects.  

To Auto Populate an Effective Date: 

1. In the Affected Prices tab, select the row(s) of price(s) that you wish to make effective from a 
desired date.  

2. Click Auto Populate Effective Date button. The Auto Populate Effective Date dialog appears. 

3. Click the calendar button next to Enter a Date field and select a date.  

4. Click Set Date.  

5. Select Apply to All Items checkbox if you wish to set the date to all the prices in Affected Prices 
tab. 

 

Removing Prices 

To remove a price from the Affected Prices table: 

1. On the Affected Prices tab, select the row(s) of the price(s) you want to remove. 

2. Click Remove. (Alternatively, you can press the Delete button on your keyboard.) 
 

Editing Prices 

You can edit a price on the Affected Prices tab of a PCO. To edit a price, click directly in an editable 
field to make necessary changes. Not all fields are editable. 

Note For the first field you attempt to edit, you will have to double-click in it to make it editable. 
Any subsequent fields will only require a single-click to enable editing. 

 

Creating and Editing Price Redlines 

On the Price List Redline sub-tab on the Affected Prices tab, you can redline the price list of an 
affected price listed on a PCO. 

To open the Price List Redline tab: 

1. On the Affected Prices tab, click the row of the price that you want to redline. The Price List 
Redline sub-tab showing existing redlines for the selected price appears below. 

2. To add price lines to the price, click Add. The Add Price Line dialog appears. For details, see 
Adding Price Lines on page 64.  

3. To edit an existing price line, click directly in the editable field and make changes, as 
necessary. 

Editing, deleting, and undoing redlines affects only the selected rows of prices on the Price Lines 
tab. 

Note You must have the required privileges to redline prices. 
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The Price List Redline tab has the following buttons: 

 Add – lets you redline-add price line to the price. 

 Remove – redline-remove the selected price line from the price. 

 Undo Redlines – clears the redlines from the selected rows. 

 More - allows you more edit options, including copy/paste and fill-up/fill-down. 
 

Workflow Tab 
The Workflow tab shows all the statuses the PCO has passed through, and which statuses remain to 
be completed. It also shows all the approvals and rejections made during each approval cycle. 

Note For detailed information about working with the Workflow tab of routable objects, see the 
chapter about routing objects with workflows in Getting Started with Agile PLM. 

For example, if a PCO is returned to the originator, reworked, and then resubmitted for a second 
approval cycle. The Workflow tab shows the approvals and rejections of the PCO made during the 
first approval cycle and during the second approval cycle. 

The Workflow tab can have the following two sections: 

 Summary Section 

 Workflow Table 
 

Summary Section 

The Summary section, the top section in the Workflow tab (visible for all changes that have been 
assigned a workflow), displays the name of the assigned workflow and a flow chart of the workflow, 
highlighting the current status of the change. 

Some of the statuses in the flow chart are links, which are identifiable by their underline. You can 
switch the change to one of these statuses by clicking the link and filling in the Notify field. You need 
sufficient privileges to do this. 

The status with an orange background is the current status. 

Workflow Table 

The Workflow table on the Workflow tab lists past workflow(s) and signoff information for the change. 
Although the Agile administrator may have modified the table, it has the following columns by 
default: 

 Status Code — an image that indicates the status or the action that was taken, e.g. current, 
forward, backward, etc. 

 Workflow — the name of the workflow that the change is following. 

 Workflow Status — the name of the status. 

 Reviewer — the user who reviewed the change. This can be an approver, observer or 
acknowledger, and it can be a single user or a user group. 
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 Req'd — whether the reviewer is a required reviewer (approver) or not (observer). 

 Action — the action taken by the reviewer. 

 Signoff User — the name of the user who actually approved or rejected the change. 

 Status Changed By — the name of the user who switched the status. 

 Local Client Time — the date and time of the action. 

 Signoff Comments — any comments made by the reviewers (approvers, observers, and 
acknowledgers) during signoff. 

 Signoff Duration — the time taken to get the signoff. 

The ability to use the Add Reviewers and Remove Reviewers buttons is controlled by the settings in 
each workflow. In addition, you must have the appropriate privileges to add or remove approvers, 
observers, or acknowledgers. If you do not have the appropriate privileges, the buttons are 
disabled. 

User Action Timestamp 
Agile provides two ways to record the date and time of any action taken against the change: 

 Local Client Time — this is the date and time as shown on the local client computer of the user 
who is viewing the timestamp. Local client time is the default method of viewing timestamps. 

For example, if Mary approves a change at 12 noon in New York (Eastern Time), when John 
looks at the Workflow tab of the change in California, he sees the time Mary approved the 
change as 9 o‘clock in the morning (Pacific Time). 

 User Action Time — this is the date and time on the computer where the action was performed. 
User action time is optional. 

If Mary approves a change at 12 noon in New York, when John in California looks at the 
Workflow tab of the change, he sees the following: 

 In the Local Client Time column, the time Mary approved the change is 9 o‘clock in the 
morning (Pacific Time). 

 In the User Action Time column, the time Mary approved the change is 12 noon (Eastern 
Time). 

When Mary looks at the Workflow tab of the change, she sees the following: 

 In the Local Client Time column, the time she approved the change is 12 noon (Eastern 
Time). 

 In the User Action Time column, the time she approved the change is 12 noon (Eastern 
Time). 

Local Client Time always appears on the Workflow tab and the History tab. User Action Time is 
optional, and is displayed on the Workflow tab of changes and the History tab of any Agile object only 
if the Agile administrator specifies this. 
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